CONTENTS

Figures
Tables
Preface

Chapter 1  Introduction  15
Overview.....................................................................................................16
NMM 9.1 compatibility with NetWorker 8.2.3 or later servers ...... 16
Stand-alone or single Exchange Servers........................................16
Exchange Server DAGs...........................................................................17
High availability in Exchange Server..................................................18
Federated IP-less DAG backup...........................................................19
DAG AutoReseed..................................................................................19
Active and passive databases.............................................................19
Shadow copy and log truncation........................................................20
Client Direct feature...........................................................................20
Using NMM in an Exchange Server environment..............................20
Exchange Server 2010 VSS writers....................................................21
Exchange Server 2013 and 2016 VSS Writer....................................21
Compatibility with previous Exchange backups...............................21
Backup-initiated transaction log file truncation.................................22
Backup types and levels.....................................................................22
Federated DAG backups.....................................................................23
Recovery types...................................................................................23

Chapter 2  Configuration  25
Supported Exchange Server deployment scenarios and limitations.....26
Supported Exchange Server versions..................................................26
Microsoft Exchange Server and Microsoft SharePoint Server
installation on the same host..............................................................26
Configuring an administrative user with the NMM Exchange Admin
Configuration tool..................................................................................26
Configuring an administrator in a parent and child domain
environment ..........................................................................................28
Configuring an administrator.............................................................29
Validating an existing administrator....................................................31
Exchange Server requirements for MAPI client and collaboration data
objects....................................................................................................32
Exchange consistency check.................................................................32
Consistency check parameters for threading and throttling.................33

Chapter 3  Exchange Server Backup Operations  35
Planning Exchange Server backups......................................................36
Backup considerations.........................................................................36
<table>
<thead>
<tr>
<th>FIGURES</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NetWorker and NMM installation in a stand-alone or single Exchange Server environment</td>
</tr>
<tr>
<td>2</td>
<td>NetWorker and NMM installation with a DAG in an Exchange Server environment</td>
</tr>
<tr>
<td>3</td>
<td>Exchange Server DAG environment</td>
</tr>
<tr>
<td>4</td>
<td>NMM Exchange Admin Configuration tool</td>
</tr>
<tr>
<td>5</td>
<td>Initial view of the Client Backup Configuration wizard</td>
</tr>
<tr>
<td>6</td>
<td>Initial view of the Client Backup Configuration wizard</td>
</tr>
<tr>
<td>7</td>
<td>Initial view of the Client Backup Configuration wizard</td>
</tr>
<tr>
<td>8</td>
<td>Adding the DAG name as an alias to a client resource</td>
</tr>
<tr>
<td>9</td>
<td>Adding the DAG name as an alias to a client resource</td>
</tr>
<tr>
<td>10</td>
<td>Example of an Exchange Server federated backup</td>
</tr>
<tr>
<td>11</td>
<td>Recovery in a stand-alone Exchange Server environment</td>
</tr>
<tr>
<td>12</td>
<td>Recovery to an alternate mailbox database in a stand-alone Exchange Server environment</td>
</tr>
<tr>
<td>13</td>
<td>Recover using NMM granular-level recovery</td>
</tr>
<tr>
<td>14</td>
<td>Recover to an RDB, and then recover data from the RDB to a user mailbox</td>
</tr>
<tr>
<td>15</td>
<td>Advanced Recovery dialog box</td>
</tr>
<tr>
<td>16</td>
<td>Exchange Recovery Summary dialog box</td>
</tr>
<tr>
<td>17</td>
<td>Manage RDB dialog box</td>
</tr>
<tr>
<td>18</td>
<td>Create RDB dialog box</td>
</tr>
<tr>
<td>19</td>
<td>Select Database dialog box</td>
</tr>
<tr>
<td>20</td>
<td>Select Server dialog box</td>
</tr>
<tr>
<td>21</td>
<td>Exchange Recovery Options window for ItemPoint GLR</td>
</tr>
<tr>
<td>22</td>
<td>Mounting the backup for ItemPoint GLR</td>
</tr>
<tr>
<td>23</td>
<td>Successful mount operation output in the Monitor page</td>
</tr>
<tr>
<td>24</td>
<td>Individual mailbox databases</td>
</tr>
<tr>
<td>25</td>
<td>Individual mailbox databases</td>
</tr>
<tr>
<td></td>
<td>Table Title</td>
</tr>
<tr>
<td>---</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1</td>
<td>Revision history</td>
</tr>
<tr>
<td>2</td>
<td>Style conventions</td>
</tr>
<tr>
<td>3</td>
<td>Writers used by NMM for Exchange Server backup and recovery</td>
</tr>
<tr>
<td>4</td>
<td>Exchange backup types and levels</td>
</tr>
<tr>
<td>5</td>
<td>User group roles configured by the NMM Exchange Admin Configuration tool</td>
</tr>
<tr>
<td>6</td>
<td>Exchange Server GLR MAPI/CDO requirements</td>
</tr>
<tr>
<td>7</td>
<td>Exchange application information variables for threading and throttling</td>
</tr>
<tr>
<td>8</td>
<td>Exchange Server 2010 save set syntax</td>
</tr>
<tr>
<td>9</td>
<td>Exchange Server 2013 save set syntax</td>
</tr>
<tr>
<td>10</td>
<td>Exchange Server 2016 save set syntax</td>
</tr>
<tr>
<td>11</td>
<td>Special characters and their URL-encoded values</td>
</tr>
<tr>
<td>12</td>
<td>Exchange Application Information attribute names and valid values</td>
</tr>
<tr>
<td>13</td>
<td>Exchange Server 2010 save set syntax</td>
</tr>
<tr>
<td>14</td>
<td>Exchange Server 2013 save set syntax</td>
</tr>
<tr>
<td>15</td>
<td>Exchange Server 2016 save set syntax</td>
</tr>
<tr>
<td>16</td>
<td>Special characters and their URL-encoded values</td>
</tr>
<tr>
<td>17</td>
<td>Exchange Application Information attribute settings</td>
</tr>
<tr>
<td>18</td>
<td>Examples of application variables</td>
</tr>
<tr>
<td>19</td>
<td>Exchange Server 2010 save set syntax</td>
</tr>
<tr>
<td>20</td>
<td>Exchange Server 2013 save set syntax</td>
</tr>
<tr>
<td>21</td>
<td>Exchange Server 2016 save set syntax</td>
</tr>
<tr>
<td>22</td>
<td>Special characters and their URL-encoded values</td>
</tr>
<tr>
<td>23</td>
<td>Exchange Application Information attribute settings</td>
</tr>
<tr>
<td>24</td>
<td>Examples for application variables</td>
</tr>
<tr>
<td>25</td>
<td>User group privileges for NMM operations</td>
</tr>
<tr>
<td>26</td>
<td>Methods for Exchange Server GLR</td>
</tr>
<tr>
<td>27</td>
<td>User credential and permission requirements</td>
</tr>
<tr>
<td>28</td>
<td>Performing a GLR to a PST recover options</td>
</tr>
</tbody>
</table>
As part of an effort to improve its product lines, EMC periodically releases revisions of its software and hardware. Therefore, some functions that are described in this document might not be supported by all versions of the software or hardware currently in use. The product release notes provide the most up-to-date information on product features.

Contact your EMC technical support professional if a product does not function correctly or does not function as described in this document.

Note
This document was accurate at publication time. Go to EMC Online Support (https://support.emc.com) to ensure that you are using the latest version of this document.

Purpose
This guide contains information about using the EMC NetWorker Module for Microsoft (NMM) Release 9.1 software to back up and recover Microsoft Exchange Server using the Volume Shadow Copy Service (VSS) technology.

Note
The *EMC NetWorker Module for Microsoft Administration Guide* supplements the backup and recovery procedures described in this guide and must be referred to when performing application-specific tasks. Download a copy of the *EMC NetWorker Module for Microsoft Administration Guide* from EMC Online Support (https://support.emc.com) before using this guide.

Audience
This guide is part of the NMM documentation set, and is intended for use by system administrators during the setup and maintenance of the product. Readers should be familiar with the following technologies used in backup and recovery:

- EMC NetWorker software
- EMC NetWorker data protection policy management
- Microsoft Volume Shadow Copy Service (VSS) technology
Revision history
The following table presents the revision history of this document.

**Table 1 Revision history**

<table>
<thead>
<tr>
<th>revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>04</td>
<td>August 1, 2017</td>
<td>Fourth release of this document for EMC NetWorker Module for Microsoft release 9.1. The following changes are included:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Updated &quot;Exchange Server GLR using EMC ItemPoint for Microsoft Exchange Server&quot; to add a note that Microsoft Outlook 2016 is not supported with EMC ItemPoint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Updated &quot;Circumstances that promote incremental or subsequent backups to level full&quot; to add information that federated backups of writer-level save sets are promoted to level full.</td>
</tr>
<tr>
<td>03</td>
<td>March 27, 2017</td>
<td>Third release of this document for EMC NetWorker Module for Microsoft release 9.1. The following changes are included:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Updated all client configuration procedures with information about using AFTDs with NetWorker server 8.2.x and NMM 9.0.1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Updated the &quot;Troubleshooting general errors&quot; section with information about mailbox structure appearing distorted in Outlook Web Access after an Exchange 2016 PIT restore operation.</td>
</tr>
<tr>
<td>02</td>
<td>February 22, 2017</td>
<td>Second release of this document for EMC NetWorker Module for Microsoft release 9.1. The following changes are included:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Changes are made throughout this document to improve organization and readability.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Updated the &quot;Recovering a deleted Exchange Server mailbox database, public folder database, or public folder mailbox database&quot; section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added the &quot;Recovering a deleted Exchange Server user mailbox&quot; section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Added Windows Server 2016 to the list of servers supported by EMC ItemPoint™ for Microsoft Exchange Server in the &quot;Granular-Level Recovery&quot; chapter.</td>
</tr>
<tr>
<td>01</td>
<td>December 22, 2016</td>
<td>First release of this document for EMC NetWorker Module for Microsoft release 9.1. The following changes are included:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The &quot;Configuration&quot; chapter is updated with information about configuring a user in a parent and child domain environment by using the NMM Exchange Admin Configuration tool.</td>
</tr>
</tbody>
</table>
Table 1 Revision history (continued)

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>- The &quot;Mail Item Recovery&quot; chapter is updated with information about recovering deleted mailboxes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The &quot;Granular-Level Recovery&quot; chapter is updated with information about Exchange server GLR requirements and limitations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The &quot;Bare-Metal Recovery&quot; chapter is added.</td>
</tr>
</tbody>
</table>

Related documentation

The NMM documentation set includes the following publications:

- EMC NetWorker Module for Microsoft Release Notes
- EMC NetWorker Module for Microsoft Administration Guide
- EMC NetWorker Module for Microsoft Installation Guide
- EMC NetWorker Module for Microsoft for SQL and SharePoint VSS User Guide
- EMC NetWorker Module for Microsoft for SQL VDI User Guide
- EMC NetWorker Module for Microsoft for Exchange VSS User Guide
- EMC NetWorker Module for Microsoft for Hyper-V VSS User Guide
- EMC ItemPoint for Microsoft SharePoint Server User Guide
- EMC ItemPoint for Microsoft Exchange Server User Guide
- EMC ItemPoint for Microsoft SQL Server User Guide
- EMC NetWorker documentation set

Special notice conventions that are used in this document

EMC uses the following conventions for special notices:

[NOTICE]

Identifies content that warns of potential business or data loss.

Note

Contains information that is incidental, but not essential, to the topic.

Typographical conventions

EMC uses the following type style conventions in this document:

Table 2 Style conventions

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Used for names of interface elements, such as names of buttons, fields, tab names, and menu paths (what the user specifically selects or clicks)</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>Used for full titles of publications that are referenced in text</td>
</tr>
<tr>
<td><strong>Monospace</strong></td>
<td>Used for:</td>
</tr>
<tr>
<td></td>
<td>• System code</td>
</tr>
<tr>
<td></td>
<td>• System output, such as an error message or script</td>
</tr>
</tbody>
</table>
Table 2 Style conventions (continued)

- Pathnames, file names, prompts, and syntax
- Commands and options

*Monospace italic* Used for variables

*Monospace bold* Used for user input

[ ] Square brackets enclose optional values
| Vertical bar indicates alternate selections - the bar means “or”
{ } Braces enclose content that the user must specify, such as x or y or z
... Ellipses indicate non-essential information that is omitted from the example

Where to get help

EMC support, product, and licensing information can be obtained as follows:

**Product information**

For documentation, release notes, software updates, or information about EMC products, go to EMC Online Support at [https://support.emc.com](https://support.emc.com).

**Technical support**

Go to EMC Online Support and click Service Center. Several options for contacting EMC Technical Support appear on the site. Note that to open a service request, you must have a valid support agreement. Contact your EMC sales representative for details about obtaining a valid support agreement or with questions about your account.

**Online communities**

Go to the EMC Community Network at [https://community.emc.com](https://community.emc.com) for peer contacts, conversations, and content on product support and solutions. Interactively engage online with customers, partners, and certified professionals for all EMC products.

**Your comments**

Your suggestions help to improve the accuracy, organization, and overall quality of the user publications. Send your opinions of this document to DPAD.Doc.Feedback@emc.com.
CHAPTER 1

Introduction

This chapter includes the following sections:

- Overview ............................................................................................................. 16
- Using NMM in an Exchange Server environment .............................................. 20
Overview

The EMC® NetWorker® Module for Microsoft (NMM) software supports backup and recovery for Microsoft Exchange Server 2010, 2013, and 2016 databases in stand-alone and database availability group (DAG) configurations.

It is recommended that you review the EMC NetWorker Online Software Compatibility Matrix at http://compatibilityguide.emc.com:8080/CompGuideApp/. The EMC NetWorker Online Software Compatibility Matrix lists the most up-to-date information about supported Windows Server versions.

NMM 9.1 compatibility with NetWorker 8.2.3 or later servers

NMM supports backup and recovery with NetWorker client version 9.1 and NetWorker 8.2.x server.


Note the following limitations when you configure NMM backup and recovery with a NMM 9.1 client and a NetWorker 8.2.3 server or later:

- Dedicated Storage Node—NetWorker 8.2.x server does not support NetWorker storage node 9.1. As a result, you cannot configure a dedicated storage node when you use NetWorker 9.1 client with NetWorker 8.2.x server.
- Volume affinity—NetWorker 8.2.x server does not support the volume affinity feature. NetWorker server 9.0 and later support the volume affinity feature. For NMM Exchange and Hyper-V, if the same volume or a volume from the same Data Domain device and taken from a prior backup cannot be obtained, an incremental-level backup is promoted to level full.
- Backup levels—NetWorker 8.2.x server uses NetWorker server 8.x backup-level definitions, and it does not support the NetWorker server version 9.0 and later backup levels.

Stand-alone or single Exchange Servers

In a stand-alone or single Exchange Server environment, all mailbox databases, log files, and checkpoint files exist on one server.

NMM is installed on the Exchange server.

The following figure illustrates the relationship between the NetWorker Server, NetWorker Management Console (NMC), and NMM client installation in a single Exchange server environment. NMM is installed on the Exchange server.
Exchange Server DAGs

NMM supports Exchange Server database availability groups (DAGs) for high availability of Exchange Server backups.

Review the following considerations for using NMM in an Exchange Server DAG environment:

- Install the NetWorker and NMM clients on each Exchange Server that has the mailbox role installed.
- When there are multiple copies of a database, only one copy of the database is active at a time. The remaining copies are passive.
- You can back up active copy mailbox databases, passive copy mailbox databases, and stand-alone databases.
- **Stand-alone** applies to an Exchange Server mailbox database that is not replicated across multiple servers, including public folder mailboxes and public folder databases.
- You can only restore backups of databases in a DAG environment to active database copies.

The Microsoft TechNet website provides additional information about the Exchange DAG architecture.

The following figure illustrates the relationship between the NetWorker Server, NetWorker Management Console, and an Exchange Server DAG. The NMM client is installed on each Exchange Server in the DAG.
The topic Roadmap for configuring Exchange Server backups on page 37 provides information about configuring a DAG backup after you install the NetWorker and NMM clients on each Exchange Server in the cluster.

**High availability in Exchange Server**

Larger enterprises typically deploy Exchange Server in some form of high-availability configuration.

Exchange Server 2010, 2013, and 2016 typically include the use of database availability groups (DAGs) and mailbox database copies. You are not required to install and configure any Windows clustering before you install Exchange Server.

You can add high availability to the Exchange Server environment after you deploy Exchange Server without uninstalling Exchange Server and then reinstalling it in a high-availability configuration. These improvements in high availability and site resilience functionality also simplify installation and configuration of the NetWorker and NMM clients for backup and recovery.
Federated IP-less DAG backup

NMM supports backups of Exchange DAG databases with no administrative access point.

This DAG type is not linked to any physical or virtual IP that can be connected on the network. An existing DAG (IP-based) cannot be converted to an IP-less DAG. Refer to the Backup chapter for more information on IP-less DAG backup configuration.

DAG AutoReseed

NMM supports AutoReseed configuration on Exchange server 2013 SP1 and later.

AutoReseed is a DAG feature that quickly restores database redundancy after a disk failure, database corruption, or other event that requires reseeding of a database copy. If the database is compromised, the database copies that are stored on the disk automatically reseed to a preconfigured spare disk on the mailbox server.

For more information about the AutoReseed feature and how to configure a DAG with AutoReseed, refer to the following article:


Active and passive databases

This topic describes NMM installations with Exchange Server 2010 and later clustered environments.

Active and passive copies of the databases exist in a clustered environment. The Exchange Server constantly updates a copy or a replica as the passive copy. For backups, the passive copy enables you to back up the databases without affecting the performance or data of the active copy. You must designate individual databases as either active or passive. This action enables you to have a mix of active and passive databases on each node.

The following figure shows an Exchange Server DAG environment with four mailbox databases (DB1, DB2, DB3, and DB4). Active and passive copies of these databases are spread over three nodes (servers MBX1, MBX2, and MBX3).
Roadmap of configuring Exchange backups provides detailed steps for configuring the NMM client on the active node after you install the NMM client on each Exchange Server in the cluster.

Shadow copy and log truncation

Shadow-copy creation is separate from the notification to VSS writers that the backup is complete. NMM registers the shadow copy as a snapshot and backs it up to media before the notification is sent to the VSS writers. If the backup to media fails, that failure is reported to the Exchange VSS writer and log truncation does not occur.

Client Direct feature

The Client Direct feature enables clients that have a direct network or a DD Boost over Fibre Channel (DFC) connection to the Data Domain system to send and receive data directly to Data Domain AFTD and DD Boost devices. Client Direct supports multiple concurrent backup and restore operations that bypass the NetWorker storage node, which eliminates a potential bottleneck. The storage node manages the devices that the clients use, but it does not handle the backup data. Client Direct was previously known as Direct File Access (DFA).

When the connection is available, NMM enables Client Direct by default and uses Client Direct to recover duplicated backups that NMM had performed with a storage node.

Using NMM in an Exchange Server environment

NMM in an Exchange Server environment supports multiple backup and recovery types, VSS writers, and is compatible with Exchange Server backups from previous versions of NMM.
Exchange Server 2010 VSS writers

Exchange Server 2010 has two writers for active and passive databases. NMM uses these writers during backup and recovery. The following table provides details.

Table 3 Writers used by NMM for Exchange Server backup and recovery

<table>
<thead>
<tr>
<th>Application writers</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information Store Writer</td>
<td>This writer is built into the Exchange Information Store. The Information Store Writer is available on any mailbox server, and is responsible for backup and recovery of active databases.</td>
</tr>
<tr>
<td>Replication Service Writer</td>
<td>This writer is built into the Replication Service. The Replication Service Writer is available on the passive node of DAGs. The Replication Service Writer supports backup functionality for a selected database where the shadow copy is taken against the replicated instance of the database and transaction log files. You can use the Information Store Writer to restore Replication Writer backups to the active database location.</td>
</tr>
</tbody>
</table>

Exchange Server 2013 and 2016 VSS Writer

Exchange Server 2013 and 2016 have one writer for active and passive databases: Microsoft Exchange Server Writer. NMM uses the Microsoft Exchange Server Writer during backup and recovery. Exchange Server-aware VSS-based applications use this writer to back up active and passive database copies and to restore backed-up database copies.

Although this writer runs in the Microsoft Exchange Replication service, it requires the Microsoft Exchange Information Store service to be running so that the writer is advertised. As a result, both services are required to back up or restore Exchange Server databases.

Compatibility with previous Exchange backups

To perform recovery from NMM version 8.2.x or earlier, select the Restore of NMM 8.2.x and Earlier Backups (VSS workflows) option in the NMM installer. The EMC NetWorker Module for Microsoft Installation Guide provides more information.

NetWorker Module for Exchange (NME) uses VDI technology and NMM uses VSS technology. As a result, you cannot directly recover data from an NME backup using NMM. If you upgraded to NMM from NME, perform a full backup of the Exchange Server using NMM to perform point-in-time recovery in the future.

Note

To ensure successful recovery, it is recommended that you perform a full backup before and after you update the Exchange Server, including service pack updates.
Backup-initiated transaction log file truncation

Exchange transaction log files behave as part of a backup.

The Microsoft Exchange Server Writer (and hence, the Exchange server) is responsible for truncating transaction logs. NMM notifies the Exchange Server Writer that a backup has completed successfully, which allows the Exchange Server Writer to continue with log truncation.

The specific point at which the Exchange Server Writer starts backup-initiated log file truncation differs for each backup type:

- In stand-alone configurations, the Exchange Server Writer truncates the transaction log files when successful full or incremental backups complete.
- In DAG configurations, the Microsoft Exchange Replication service delays the log truncation until all necessary log files are replayed into all other copies. After the Microsoft Exchange Replication service verifies that the to-be-deleted log files have been applied to the copy database and active and passive databases, the Replication service deletes the backed-up log files from both the active and passive copy log file paths.

Backup types and levels

The Exchange Server block-based backup is the default and only method to back up an Exchange Server with NMM.

NMM uses NetWorker block-based backup technology to perform backups of stand-alone and DAG Exchange environments. Block-based technology tracks changed blocks of the Exchange database and log files. When a level incremental backup is started, only the changed blocks are backed up. When a level full backup is started, each selected Exchange database and all necessary log files are backed up.

The following table provides information about NetWorker backup levels and the resulting backup levels for Exchange Server backups:

<table>
<thead>
<tr>
<th>Target device type</th>
<th>Supported backup levels</th>
<th>Resulting save set level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Domain device</td>
<td>Full</td>
<td>Full</td>
</tr>
<tr>
<td></td>
<td>Incremental</td>
<td>Full</td>
</tr>
<tr>
<td>AFTD</td>
<td>Full</td>
<td>Full</td>
</tr>
<tr>
<td></td>
<td>Incremental</td>
<td>Incremental</td>
</tr>
</tbody>
</table>

**Note**

Logs-only and synthetic-incremental backup levels are not supported with Exchange server backups.

The *EMC NetWorker Module for Microsoft Administration Guide* provides more details about backup levels and block-based backup.
Federated DAG backups

NMM supports federated backups for Exchange Server DAGs and IP-less DAGs, including stand-alone and public folder databases.

Federated backups allow you to back up all databases in a DAG with a single save set across all Exchange Server nodes in the DAG. NMM does not require that you back up each node separately.

Note

NMM does not support backup operations for individual mailbox servers within a DAG. Non-federated backups are supported for stand-alone configurations only.

Recovery types

NMM supports the following types of recovery:

- Roll-forward recovery
- Point-in-time recovery
- Database recovery to Exchange RDB
- Remote database recovery for Exchange Server DAG
- Exchange RDB mailbox browsing, mailbox, folder, and message recovery
- Recovery to alternate mailbox database
- Recovery to alternate Mailbox
- Granular-level recovery (GLR) to/from RDB
- Granular-level recovery (GLR) to alternate mailbox
- Granular-level recovery (GLR) to PST files

Note

Recovery databases are not supported with Exchange Server 2016. Granular-level recovery of Exchange Server 2016 is supported only through EMC® ItemPoint™ for Microsoft Exchange Server. See the Granular-Level Recovery chapter for more information on GLR.
CHAPTER 2
Configuration

This chapter includes the following sections:

- Supported Exchange Server deployment scenarios and limitations .................. 26
- Configuring an administrative user with the NMM Exchange Admin Configuration tool .................................................................................................................... 26
- Exchange Server requirements for MAPI client and collaboration data objects ..........................................................32
- Exchange consistency check .................................................................................. 32
Supported Exchange Server deployment scenarios and limitations

The Microsoft Exchange Server documentation provides a complete and updated list of system requirements and supported configurations.

The EMNetWorker Online Software Compatibility Matrix, available at http://compatibilityguide.emc.com:8080/CompGuideApp/, provides the most up-to-date and accurate listing of hardware, operating system, service pack, and application versions that NMM supports.

Supported Exchange Server versions


Microsoft Exchange Server and Microsoft SharePoint Server installation on the same host

Microsoft does not support the installation of Microsoft Exchange Server and Microsoft SharePoint Server on the same host. Consequently, NMM does not support this installation.

Configuring an administrative user with the NMM Exchange Admin Configuration tool

The NMM Exchange Admin Configuration tool enables you to create or reset account permissions with the necessary privileges to perform backup and recovery operations on an Exchange Server. After installing NMM, use the tool to create an account, or to modify, validate, and update existing account privileges.

You must configure a user after installing NMM. When NMM is installed with the NMM Installation wizard, the NMM Exchange Admin Configuration tool runs automatically. When NMM is installed silently, you must manually open the NMM Exchange Admin Configuration tool.

To use the NMM Exchange Admin Configuration tool, you must be logged in with Domain Administrator permissions. You can use the Exchange NMM Admin Tool to create users, configure existing users, and assign correct permissions to existing users.

Note

NMM uses the user account that is set in the registry by the NMM Exchange Admin Configuration tool to perform backup, database, or granular-level recovery.

The following figure shows the NMM Exchange Admin Configuration tool landing page.
You can use the NMM Exchange Admin Configuration tool to perform the following tasks:

**Configure Admin User**
You can perform the following actions after clicking **Configure Admin User**:

- Create an NMM Exchange Admin user, configure the permissions that are required for Exchange backup and recovery (both database and GLR), and set the user account in the registry.
- Update an existing Exchange Admin user's permissions to those that are required for Exchange backup and recovery (both database and GLR), and set the NMM Exchange administrator account in the registry.
- Set an existing user as an NMM Exchange Admin account in the registry.

**Update Admin Password**
Click **Update Admin Password** to modify the NMM Exchange administrator account password and update the registry.

**Validate an existing Admin**
Click **Validate an existing Admin** to verify that an existing NMM Exchange administrator account is correctly configured.

**NMM Exchange Admin Configuration tool operations**
The NMM Exchange Admin Configuration tool simplifies configuring security group memberships by ensuring that users have all the required Active Directory security group memberships and PowerShell management roles.

You can assign users to an Organization Management role, or you can assign them to the EMC NMM Exchange Admin Role group. If you assign a user to the EMC NMM Exchange Admin Role group, that user is removed from the Organization Management role. Conversely, if you assign a user to the Organization Management role, that user is removed from the EMC NMM Exchange Admin Role group. The EMC NMM Exchange Admin Role group is not created unless at least one user is configured without Organization Management rights.

To create an NMM Exchange Administrator account, the tool automatically performs the following steps:

1. Creates an Active Directory user account.
2. Creates a custom Exchange security group.
3. Adds the NMM Exchange Administrator account to the user groups listed in the following table.
**Table 5** User group roles configured by the NMM Exchange Admin Configuration tool

<table>
<thead>
<tr>
<th>User group</th>
<th>Exchange Server role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security group memberships on NMM Client computer</td>
<td>Local Administrator</td>
</tr>
<tr>
<td>Security group memberships on Domain Controller</td>
<td>• Backup Operators</td>
</tr>
<tr>
<td></td>
<td>• Remote Desktop Users</td>
</tr>
<tr>
<td>Exchange Security Group memberships</td>
<td>• Exchange Servers</td>
</tr>
<tr>
<td></td>
<td>• Organization Management or EMC NMM Exchange Admin Roles</td>
</tr>
<tr>
<td></td>
<td>• EMC NMM Exchange Admin Roles</td>
</tr>
<tr>
<td></td>
<td>• Database Copies</td>
</tr>
<tr>
<td></td>
<td>• Databases</td>
</tr>
<tr>
<td></td>
<td>• Disaster Recovery</td>
</tr>
<tr>
<td></td>
<td>• Mailbox Import Export</td>
</tr>
<tr>
<td></td>
<td>• Mail Recipient Creation</td>
</tr>
<tr>
<td></td>
<td>• Mail Recipients</td>
</tr>
<tr>
<td></td>
<td>• View-Only Configuration</td>
</tr>
<tr>
<td></td>
<td>• View-Only Recipients</td>
</tr>
</tbody>
</table>

4. Assigns the *Mailbox Import Export* management role to the user.
5. Creates an Exchange mailbox.
6. Assigns Send-As and Receive-As rights.
7. Registers the user account for backup and recovery on Exchange servers where NMM is installed.

**Configuring an administrator in a parent and child domain environment**

Consider the following when configuring a user in a parent and child domain environment.

When the NMM Exchange Admin Configuration Tool is run on a node that is part of a child domain to configure a user in a parent and child domain environment, the user is added to the Active Directory of the child mailbox server. The user inherits security group memberships from the parent domain.

The NMM Exchange Admin Configuration Tool does not support user configurations for the following scenarios:

- To create a user in the parent Active Directory from a child mailbox server.
- To create a user in the child Active Directory from a parent mailbox server.
- To create a user from a child or parent mailbox server in a different domain of the same forest.

Manually configure a user in these scenarios. See the example "Manually configuring an Exchange backup Admin user" in the section *Examples of administrative user configurations* on page 30 for more information about this configuration.
Configuring an administrator

You can configure an administrator user with the NMM Exchange Admin Configuration tool by creating an account, or by using an existing account.

Procedure

1. In the NMM Exchange Admin Configuration window, click Configure Admin User.

2. Under Action, select one of the following options:
   - Create new admin—Create an Exchange user account for NMM backup and recovery operations.
   - Configure existing user—Use an existing Exchange user account for NMM backup and recovery operations.

3. Type the User Name and Password.

4. If you are creating an account:
   a. In the Confirm Password field, retype the password.
   b. From the Database list, select the Exchange database for which the user will perform backups and recoveries.

5. (Optional) Select Assign Organization Management rights.
   Members of the Organization Management role group have permissions to manage Exchange objects and their properties in the Exchange organization. Members can also delegate role groups and management roles in the organization.

   **Note**
   If you select Assign Organization Management rights, NMM adds the user to the Organization Management group. The tool does not create an NMM Exchange Admin Roles security group.
   If you do not select this option and also do not select the Skip Active Directory Authentication option, NMM will create an Active Directory security group called EMC NMM Exchange Admin Roles and add the user to that group.

6. (Optional) Select Create ContentSubmitters security group.
   This option creates a ContentSubmitters Active Directory security group. This option is unavailable if a ContentSubmitters group is already created in the Active Directory. This option is available only on Exchange Server 2013 and 2016.

7. (Optional) If you are configuring an existing user, select Skip Active Directory Authentication.
   This option skips the Active Directory authentication and authorization operations for the user, and only sets the user as the NMM Exchange user account in the registry for backup and recovery operations.
This option should be selected when you manually configure a user. See the example "Manually configuring an Exchange backup Admin user" in the section Examples of administrative user configurations on page 30 for more information about this configuration.

8. Click **Configure**.

   The output window shows the status of the configure operation, including any warning or error messages.

9. (Optional) To verify that all the configurations are correctly set, run the System Configuration Checker.

**Results**

The user receives the necessary permissions to backup and restore the Exchange database. View the configured user in the **Members** tab in the Properties window of the Exchange Servers security group.

**Examples of administrative user configurations**

This section provides examples of configuring an administrator with the NMM Exchange Admin Configuration tool.

**Example 1** Configuring or modifying an Admin user with Organization Management rights

The user will be a member of the Organization Management group, but will not be a member of the EMC Exchange NMM Admin Roles group.

1. In the **NMM Exchange Admin Configuration** window, click **Configure Admin User**.

2. Complete the **Configure Admin User** page, and then select **Assign Organization Management rights**.

3. Click **Configure**.

4. Verify that all the configurations are correctly set, System Configuration Checker.

**Example 2** Configuring or modifying an Admin user without Organization Management rights

The user will be a member of the EMC Exchange NMM Admin Roles group, but will not be a member of the Organization Management group.

1. In the **NMM Exchange Admin Configuration** window, click **Configure Admin User**.

2. Complete the **Configure Admin User** page. Ensure that **Assign Organization Management rights** is not selected.

3. Click **Configure**.

4. Verify that all the configurations are correctly set by running the System Configuration Checker.

**Example 3** Manually configuring an Exchange backup Admin user
Example 3  Manually configuring an Exchange backup Admin user (continued)

1. Configure the user manually in Active Directory, and ensure that the user has the appropriate roles and rights, as described in Configuring an administrative user with the NMM Exchange Admin Configuration tool on page 26.

2. In the NMM Exchange Admin Configuration window, click Configure Admin User.

3. On the Configure Admin User page:
   a. Select Configure Existing User.
   b. In the User Name and Password fields, type the required information.
   c. Select Skip Active Directory Authentication.
   d. Click Configure.

4. Verify that all the configurations are correctly set by running the System Configuration Checker.

Validating an existing administrator

Use the NMM Exchange Admin Configuration tool to verify that an existing NMM Exchange administrator account is correctly configured.

Note

Validating an existing administrator in a parent and child domain environment can fail because the tool might try to contact Active Directory to validate credentials from the registry.

Procedure

1. In the NMM Exchange Admin Configuration window, click Validate an existing Admin.

2. In the User Name and Password fields, type the required information.

3. Click Validate.

   A window that lists the Exchange servers in your environment opens.

4. Select each server that the user must back up or recover, and then click OK.

   The window closes and the validate operation starts. The output window shows the status of the operation including any warning or error messages.

Results

The output window shows the results of the validate operation.
Exchange Server requirements for MAPI client and collaboration data objects

NMM requires Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 Kit for granular-level recovery (GLR) of Exchange Servers through the NMM UI.

Note

NMM also supports GLR of Exchange Servers with EMC ItemPoint® for Microsoft Exchange Server. It is recommended that you use ItemPoint for Microsoft Exchange Server for GLR instead of the NMM UI. See the "Exchange server GLR using ItemPoint" section in the EMC NetWorker Module for Microsoft for Exchange VSS User Guide for the required Outlook version. If you use EMC ItemPoint for Microsoft Exchange Server, MAPI is not required for GLR.

Table 6 Exchange Server GLR MAPI/CDO requirements

<table>
<thead>
<tr>
<th>Exchange Server version</th>
<th>Required MAPI/CDO version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange Server 2010</td>
<td>MAPI/CDO 1.2.1 version 6.5.8244.0 or earlier</td>
</tr>
<tr>
<td>Exchange Server 2013</td>
<td>MAPI/CDO 1.2.1 version 6.5.8320.0 or later</td>
</tr>
<tr>
<td>Exchange Server 2016</td>
<td>Not applicable. GLR of Exchange Server 2016 is supported only through EMC ItemPoint for Microsoft Exchange Server.</td>
</tr>
</tbody>
</table>

The Exchange Server 2010 and 2013 software does not include the MAPI client libraries and CDO. You can download the client library and CDO package from Microsoft’s website. For information about downloading and installing this software, search for "Microsoft Exchange MAPI Client and Collaboration Data Objects" on the Microsoft Download Center website.

The EMC NetWorker Online Software Compatibility Matrix at http://compatibilityguide.emc.com:8080/CompGuideApp/ contains information about the most recent version of the MAPI and CDO kit that NMM supports.

Exchange consistency check

Exchange consistency checks improve the quality and performance of a backup operation.

The Exchange consistency check occurs at the time of a backup operation and verifies that the database and its corresponding set of transaction logs do not contain errors (such as on-disk data corruption). This feature validates that the Exchange backup is viable and will not cause issues when it is restored.

You can configure a consistency check to check the database and log files, only the database files, or only the log files. A consistency check of only the database does not ensure complete consistency of the backup, but it does take less time to perform this type of consistency check.
Consistency check parameters for threading and throttling

The larger the databases and associated transaction logs, the longer it takes to run a consistency check. To reduce the amount of time it takes to perform a consistency check on large databases, NMM provides the option to run a consistency check on multiple databases in parallel.

NMM provides throttling parameters to govern the use of system resources during a consistency check. While the default throttling limit is 1000 ms, you can set the throttle limit according to the setup. If you run simultaneous consistency checks without adjusting the throttle limits, the Exchange server performance can suffer. In extreme cases, the I/O bottlenecks cause the consistency checks to fail and other system operations are adversely affected.

You can configure threading and throttling to prevent performance issues during backup. Use the attribute values from the following table in the Application Information field of the NMM client.

Table 7 Exchange application information variables for threading and throttling

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
<th>Default and valid values</th>
</tr>
</thead>
</table>
| NSR_ESE_UTIL_SEQUENTIAL             | Optional, specifies whether to run Eseutil in parallel (multi-threaded) or sequentially (single-threaded). | • False (default)—Runs eseutil in parallel (multi-threaded) with a default maximum of 4 parallel threads.  
• True—Runs eseutil sequentially (single-threaded).  
• number_of_threads—Specifies the number of parallel threads to use. For example: NSR_ESE_UTIL_SEQUENTIAL=6 |
| NSR_ESE_UTIL_THROTTLE               | Optional, specifies whether to allow throttling.                             | • False (default)—Prevents eseutil throttling, ignoring all other throttling parameters.  
• True—To Allows eseutil throttling.                                                                |
| NSR_ESE_THROTTLE_IOS                | Optional, specifies the number of I/Os between pauses when throttling. This attribute is useful to limit disk utilization. | • Undefined (default)—The default value is 100.  
• Valid defined values are 100–10000. For example: NSR_ESE_THROTTLE_IOS=500 |
<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
<th>Default and valid values</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSR_ESE_THROTTLE_DURATION</td>
<td>Optional, specifies the duration of pause in milliseconds when throttling.</td>
<td>• Undefined (default)—The default value is 1000.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Valid defined values are 1000–60000.</td>
</tr>
<tr>
<td>NSR_ESE_CC_METHOD</td>
<td>Optional, specifies whether to perform the consistency check on the database</td>
<td>• DB_AND_LOGS (default) —Performs a consistency check on the</td>
</tr>
<tr>
<td></td>
<td>and log files, database file only, or log files only.</td>
<td>database and log files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DB_ONLY—Performs a consistency check on the database files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• LOGS_ONLY—Performs a consistency check on the log files only.</td>
</tr>
</tbody>
</table>

**Table 7 Exchange application information variables for threading and throttling (continued)**
CHAPTER 3
Exchange Server Backup Operations

This chapter includes the following sections:

- Planning Exchange Server backups .................................................................36
- Roadmap for configuring Exchange Server backups ....................................37
- Configuring backups of a stand-alone server ..................................................39
- Configuring federated backups of a DAG .........................................................45
- Configuring NetWorker privileges manually ....................................................68
- Modifying a client resource after upgrading from NMM version 8.2.x or earlier
  .........................................................................................................................69
- Verifying a backup ............................................................................................70
Planning Exchange Server backups

This section helps you plan an Exchange Server backup.

Backup considerations

Consider the following information when you perform Exchange Server backups:

- In a stand-alone environment, schedule backups using the FQDN or hostname of the NetWorker client computer.
- In a traditional DAG environment with an IP, schedule federated backups using the DAG name.
- In an IP-less DAG environment, schedule federated backups using a physical mailbox server in the DAG.
- You cannot interrupt or halt the Exchange backup process. For example, in an Exchange backup, the nsrnmmsv.exe process on the production server and the Eseutil process on the proxy resource might continue to run after you stop the backup. If you try to stop the backup in the NMC, the process might take a long time to complete.
- NMM backs up only mounted databases. If any databases are unmounted, NMM does not display notifications during the backup operation and the backup operation will be reported as successful. The NMM log files provide details about unmounted databases.

Exchange backup prerequisites

Ensure that you meet the following prerequisites before you perform backup procedures:

- Install the required .NET Framework version. The EMC NetWorker Module for Microsoft Release Notes provides more information about the required .NET Framework version.
- Install the hotfixes and cumulative updates.
- When configuring backup and recovery of a database availability group (DAG), ensure that each DAG node uses the same version of Exchange Servers, Windows Servers, and service packs or cumulative updates.
- Install the NetWorker client and NMM software on all Exchange Servers that you want to backup.

Circumstances that promote incremental or subsequent backups to level full

Incremental or subsequent backups promote to a level full block-based backup during the following circumstances:

- When you perform federated backups of writer-level save sets. You can only perform incremental backups of database-level save sets. As a workaround, if you are using NMM 9.x with a NetWorker 8.2.x server, set the schedule level to incremental and enable the Force incremental option in the Group resource.
- When NMM cannot find a full backup for the database within the specified save set.
When you add a Mailbox database to an existing save set.
When NMM detects gaps between the last backup and the current set of logs. For example, there are gaps between the highest log number that is retrieved from index and the lowest log number that is retrieved from the disk.
When you change the database or the log path after the last full backup.
When you reinstall NMM.
When you restart the backup client (Exchange Server).
When you expand the disk size where an Exchange mailbox database resides.

Roadmap for configuring Exchange Server backups
To perform an Exchange Server backup, complete the following tasks:

1. Configure the backup storage resources.
2. Review the Exchange Server backup options that are described in Backup configuration options on page 37.
3. Configure one or more client resources for each client using either the Client Backup Configuration Wizard or the Client Properties dialog box.
4. Configure a data protection policy for scheduled backups, including a group, policy, policy workflow, and backup action.

Note
If you are using NetWorker server 8.2.3 or later, configure a regular NetWorker backup group instead of configuring a data protection policy. Do not enable the Snapshot option.

5. Configure privileges as described in Configuring NetWorker privileges.

The EMC NetWorker Module for Microsoft Administration Guide and the EMC NetWorker Administration Guide provide details on how to perform these tasks.

Backup configuration options
This section describes the backup configuration options for Exchange Server backups based on the environment.

Back up using the Client Direct feature
NMM supports the Client Direct feature, which enables client backups to bypass the NetWorker storage node and perform one of the following operations:

- Send deduplicated backup data directly to Data Domain Boost (DD Boost™) devices.
- Send backup data directly to an advanced file type device (AFTD).

The Client Direct feature, also known as direct file access or DFA, reduces bandwidth use and bottlenecks at the storage node, and it provides highly efficient transmission of backup data. Client Direct is the default and preferred backup method. If an NMM backup cannot use the Client Direct feature because of inadequate permissions or inaccessibility to the target device, the backup uses the storage node instead. For NMM 9.0 and later, if an NMM backup cannot use the Client Direct feature, the backup fails.
Note

NMM does not support dedicated storage nodes in a DAG environment when you use NMM 9.1 with a NetWorker 8.2.3 or later server. When you configure the storage node in a DAG environment, in the **Device properties** dialog box, for the Dedicated storage node option, select **No**. Refer to the "Configuring backups to use a remote storage node in a DAG environment" section in the Exchange Server Backup Operations chapter for information about how to use a remote storage node in a DAG environment.

**Back up only active databases on the server**
You can back up all the active database copies that reside on an Exchange Server mailbox server in a DAG environment. You can perform full and incremental backups. Active node backups include stand-alone servers, public folder mailboxes (Exchange Server 2013 and 2016), and public folder databases (Exchange Server 2010).

**Back up only passive databases on the server**
You can back up all the passive database copies that reside on an Exchange Server mailbox server in a DAG environment. You can perform full and incremental backups, including incremental backups of public folders. Passive node backups do not include public folder mailboxes or public folder databases.

**Back up both active and passive databases on the server**
You can back up both active and passive databases on Exchange Server mailbox servers in the DAG environment. You can perform both full and incremental backups.

**Back up to a local storage node in a stand-alone environment**
You can configure a client to direct its backups to the local storage node on the physical host on which it resides. To configure a stand-alone client, type `curphyhost` in the Storage Nodes attribute of the stand-alone client. This variable is not supported for DAG environments. The *EMC NetWorker Cluster Integration Guide* provides more information about the `curphyhost` command.

**Back up to a remote storage node in a DAG or stand-alone environment**
You can perform Exchange Server database backups using a remote NetWorker storage node. You can perform both full and incremental backups.

Note

NMM does not support dedicated storage nodes in a DAG environment when you use NMM 9.1 with a NetWorker 8.2.3 or later server. When you configure the storage node in a DAG environment, in the **Device properties** dialog box, for the Dedicated storage node option, select **No**. Refer to the "Configuring backups to use a remote storage node in a DAG environment" section in the Exchange Server Backup Operations chapter for information about how to use a remote storage node in a DAG environment.
Configuring backups of a stand-alone server

You can configure a backup of a stand-alone server using either the Client Backup Configuration wizard or the Client Properties window.

Configure a stand-alone server backup using the Client Backup Configuration wizard

Before you begin

To use the Client Backup Configuration wizard, you must first install the NMM client on the Exchange server and run the NMM Exchange administration configuration tool.

Note

If you are using NetWorker server 8.2.3 or later and NMM 9.1:

- Configure a regular NetWorker backup group instead of configuring a data protection policy. Do not enable the Snapshot option.
- For the Client Backup Configuration wizard to function properly, ensure that JRE 8 is installed on the system where the NetWorker Management Console (NMC) is used. While the NMC for NetWorker 8.2.3 and later is compiled with JRE 7, the NMM 9.1 Java plugin for NMC is compiled with JRE 8.
- If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x, ensure that the Block based backup checkbox is cleared in the client resource. If you do not clear this setting, incremental backups are promoted to level full.
- The procedure that creates a client resource when using NetWorker server 8.2.3 and later is different from the procedure that creates a client resource when using NetWorker server 9.1. Follow the procedure provided in the EMC NetWorker Module for Microsoft for Exchange VSS User Guide version 8.2 SP1.
- Before you start the NMM 9.1 Client Backup Configuration wizard to modify a client resource that was created with NMM 8.2.x, ensure that the Snapshot attribute of the NetWorker group that this client resource belongs to is clear. If the Snapshot attribute is selected, you cannot select the NetWorker group in the wizard and you are prompted to create or select another group.

Procedure

1. Open the NetWorker Management Console (NMC) and launch the NetWorker Administration UI.
2. In the left navigation pane of the Protection tab, right-click Clients and select New Client Wizard.

The following figure shows the initial view of the Client Backup Configuration wizard.
3. On the **Specify Client Information** page:
   
   a. In the **Client Name** field, type one of the following:
      
      - The FQDN of the NetWorker client computer
      - The hostname of the NetWorker client computer
   
   b. (Optional) In the **Comment** field, type a description of the client.
   
   c. (Optional) In the **Tag** field, type one or more tags to identify this client resource for the creation of dynamic client groups for data protection policies. Place each entry on a separate line.
   
   d. (Optional) In the **Group** field, select a group to assign the client resource to.
      
      The group to which the client belongs determines the workflow that is used to back up the client.
   
   e. In the **Type** box, select **Traditional**.
   
   f. Click **Next**.

4. On the **Specify the Backup Configuration Type** page, select **Microsoft Exchange Server**, and then click **Next**.

5. On the **Select the NetWorker Client Properties** page, complete the following steps.
   
   a. Specify the client properties. The following list explains the properties:
      
      - **Priority**—Enables you to control the order in which the NetWorker server contacts clients for backup.
      - **Parallelism**—Specifies the maximum number of data streams that a client can send simultaneously during a backup operation.
• **Remote Access**—Specifies a list of users who can access to perform remote access operations.

• **Data Domain Interface**—Specifies the protocol to use if you send the backup data to a Data Domain Device. Available selections are IP, Fiber Channel, or Both.

• **Block based backup (BBB)**—Enables block-based backups for the host. This option is selected by default. You cannot clear this option for Exchange client resources.

• **Client direct**—Enables the client to connect directly to the backup storage device instead of connecting to a NetWorker storage node. This option is selected by default. You cannot clear this option for Exchange client resources.

b. Click **Next**.

6. On the **Select the Exchange Server Objects** page, verify that the databases to back up are selected, and then click **Next**.

   By default, all databases are selected for the entire server backup. Clear the checkbox for any items that must be excluded from the backup.

7. The **Specify Federated Exchange Backup Options** page appears. In the **Consistency Check Options** group, enable consistency checks by selecting **Perform a consistency check during backup**. Configure the following settings:

   a. To validate Exchange databases and logs, databases only, or logs only, select **Perform database consistency check during backup**.

      In a stand-alone environment, the **Perform database consistency check during backup** option is selected by default.

   b. To validate the Exchange files sequentially instead of in parallel, select **Sequential consistency check**.

   c. To manage the performance of the Consistency Check operation, select **Throttle Consistency Check**, and then select **Throttle I/O Operations** and **Throttle Duration**.

      You can configure the number of consistency check I/O operations in each cycle and the length of the pause between I/O operation cycles.

8. On the **Client Configuration Summary** page, review the details and perform one of the following actions:

   • Click **Back** to revisit the previous pages.

   • Click **Create** to configure the client resources.

9. On the **Check Results** page, review the output of the Client Backup Configuration wizard, and click **Finish**.

**Results**

The client resource appears in the **Clients** window pane.
Configure a stand-alone server backup using the Client Properties window

This section describes how to configure a client resource for a stand-alone server using the **Client Properties** window in the NMC.

### Note

The procedure that creates a client resource when using NetWorker server 8.2.3 and later is different from the procedure that creates a client resource when using NetWorker server 9.1. Follow the procedure provided in the *EMC NetWorker Module for Microsoft for Exchange VSS User Guide* version 8.2 SP1. Keep the following considerations in mind when following the NMM 8.2 SP1 procedure:

- Configure a regular NetWorker backup group instead of configuring a data protection policy. Do not enable the Snapshot option.
- If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x, ensure that the Block based backup checkbox is cleared in the client resource. If you do not clear this setting, incremental backups are promoted to level full.
- In the **Client Properties** window, on the **Apps & Modules** tab, in the **Backup Command** field, type `nsrnmmsv.exe`.

### Procedure

1. In the **Administration** view of the NetWorker Management Console (NMC), click **Protection**.
2. In the expanded left pane, select **Clients**.
3. From the **File** menu, select **New**.
4. On the **General** tab, perform the following actions:
   a. In the **Name** field, type one of the following:
      - The FQDN of the NetWorker client computer
      - The hostname of the NetWorker client computer
   b. In the **Comment** field, type a description.
   c. Ensure that **Block based backup** is selected.
   d. Determine a list of save sets that must be included in the backup.

   To display a list of the application data save sets that are available for backup, open a command prompt on the Exchange server and type the following command.

### Note

Before using this command, use the NMM Exchange administrator configuration tool to create an NMM Exchange administrator account.

```
nsrnmmsv -P
```

The following list of save sets is example output from this command:

```
"APPLICATIONS:\Microsoft Exchange 2010"
"APPLICATIONS:\Microsoft Exchange 2010\DB1"
"APPLICATIONS:\Microsoft Exchange 2010\DB2"
```
“APPLICATIONS:\Microsoft Exchange 2010\DB3”
“APPLICATIONS:\Microsoft Exchange 2010\DB4”
“APPLICATIONS:\Microsoft Exchange 2010\DB5”

The output contains all databases in a database availability group (DAG). The \-v option is not supported for DAGs. Each line of output corresponds to a save set entry that you can add to the save set attribute of a client resource. Type each entry on a separate line.

**Note**

Remove the quotation marks when copying the save set name from the output.

e. In the Save Set field, specify the components to be backed up.

The following table provides the Exchange Server 2010 save set syntax for application data.

**Table 8** Exchange Server 2010 save set syntax

<table>
<thead>
<tr>
<th>Type of backup data</th>
<th>Save set syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writer level</td>
<td>APPLICATIONS:\Microsoft Exchange 2010</td>
</tr>
<tr>
<td>Database name level</td>
<td>APPLICATIONS:\Microsoft Exchange 2010&lt;Database name&gt;</td>
</tr>
</tbody>
</table>

The following table provides the Exchange Server 2013 save set syntax for application data.

**Table 9** Exchange Server 2013 save set syntax

<table>
<thead>
<tr>
<th>Type of backup data</th>
<th>Save set syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writer level</td>
<td>APPLICATIONS:\Microsoft Exchange 2013</td>
</tr>
<tr>
<td>Database name level</td>
<td>APPLICATIONS:\Microsoft Exchange 2013&lt;Database name&gt;</td>
</tr>
</tbody>
</table>

The following table provides the Exchange Server 2016 save set syntax for application data.

**Table 10** Exchange Server 2016 save set syntax

<table>
<thead>
<tr>
<th>Type of backup data</th>
<th>Save set syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writer level</td>
<td>APPLICATIONS:\Microsoft Exchange 2016</td>
</tr>
<tr>
<td>Database name level</td>
<td>APPLICATIONS:\Microsoft Exchange 2016&lt;Database name&gt;</td>
</tr>
</tbody>
</table>

When you specify save set names in the Save Set field of the client resource, you must specify some special characters, such as the backward slash (\), by their URL-encoded values.

The following table lists the most commonly used special characters and their URL values.
Table 11 Special characters and their URL-encoded values

<table>
<thead>
<tr>
<th>Special character</th>
<th>URL-encoded value</th>
<th>Special character</th>
<th>URL-encoded value</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>%5C</td>
<td>?</td>
<td>%3F</td>
</tr>
<tr>
<td>/</td>
<td>%2F</td>
<td>]</td>
<td>%5D</td>
</tr>
<tr>
<td>&quot;</td>
<td>%22</td>
<td>[</td>
<td>%5B</td>
</tr>
<tr>
<td>%</td>
<td>%25</td>
<td>}</td>
<td>%7D</td>
</tr>
<tr>
<td>#</td>
<td>%23</td>
<td>{</td>
<td>%7B</td>
</tr>
<tr>
<td>&amp;</td>
<td>%26</td>
<td>^</td>
<td>%5E</td>
</tr>
<tr>
<td>&lt;</td>
<td>%3C</td>
<td>'</td>
<td>%60</td>
</tr>
<tr>
<td>&gt;</td>
<td>%3E</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

f. In the Protection group list field, select the appropriate option.

5. Click the Apps & Modules tab and perform the following actions:

a. In the Access area, leave the Remote user and Password fields empty.

b. In the Backup command field, type the following backup command:

   nsnrnmmsv.exe

   c. In the Application Information field, type the required variables and values. If you specify more than one Exchange Application Information attribute at a time, type each attribute name and its value on a separate line.

   The following table provides the Exchange Application Information attribute names and valid values.

Table 12 Exchange Application Information attribute names and valid values

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
<th>Default and valid values</th>
</tr>
</thead>
</table>
| NSR_EXCH_CHECK=value                | Optional. Specifies if a consistency check should be run for databases.     | • Yes—Runs a consistency check. This is the default value for Exchange Server stand-alone backups.  
                                         |                                                                             | • No—Does not run a consistency check.  
                                         |                                                                             | If the value is no, NMM indicates that the consistency check is omitted from the backup log. |
| NSR_EXCH_BACKUP=active/passive/preferred/all | Optional. Specifies whether to back up active, passive, preferred, or all of the database copies. | • Preferred (default)—Backs up only a passive copy or replica of each database. If no passive database exists, the active database is backed up.  
                                         |                                                                             | • Active—Backs up only active database copies.  
                                         |                                                                             | • Passive—Backs up only passive database copies.  
                                         |                                                                             | • All—Backs up both active and passive databases. |
| NSR_EXCLUDE_COMPONENTS=db1,db2...    | Optional. Excludes specified databases from backup                          | • Undefined (default).  
                                         |                                                                             | • To exclude databases from the backup, type a comma-separated list of their names. |

The following list items are examples of application variables:
6. Ensure that **Client Direct** is enabled.

   Exchange backups require Client Direct.

7. Click the **Globals (1 of 2)** tab and verify that the **Aliases** attribute displays the NETBIOS name for the client.

   This name is filled in automatically.

   The NMM client uses the host computer NETBIOS or “short” name when it connects to the NetWorker server to browse backups. If the NETBIOS name is not found, NMM does not display backups.

8. If you are using a NetWorker storage node that is different from the NetWorker server, when you configure a client resource for the Exchange Server, click the **Globals (2 of 2)** tab, and in the **Storage node name** field, type the storage node name.

9. Click **OK**.

**Results**

The client resource appears in the **Clients** window pane of NMC.

---

**Configuring federated backups of a DAG**

This section describes how to configure and perform federated database availability group (DAG) backups.

NMM supports backup configurations of IP DAG (with an administrative access point) and IP-less DAG (with no administrative access point).

**Performing backups in a DAG environment**

In a highly available database availability group (DAG) environment, you can schedule federated backups by using the DAG name or the DAG node name as the client instance.

To back up an IP-less DAG, use a physical mailbox server in the DAG to configure a client resource, then add the DAG short name and FQDN as an alias to the client resource. Use this client to schedule federated backups of the IP-less DAG.

When backing up active or passive database copies in the Exchange DAG environment, all DAGs use the federated backup method to best handle fail over scenarios. The federated backup method provides the following benefits:

- It allows backups of passive database copies to continue even when the passive database copies move among Exchange servers.
- It enables you to back up all DAG members, including stand-alone and public folder mailbox databases, with a single save set without running a separate backup of each node. Each Exchange server for which a backup job is sent performs its backups in parallel with the other Exchange servers, which results in faster backups.
Preferred server order list

When you perform a backup through the DAG resource with the **NSR_EXCH_BACKUP** attribute set to **Passive** or **Preferred**, NMM selects an Exchange server to back up the passive copies of the databases. Because multiple Exchange servers can host replicas or passive copies of the same database, you can specify a preferred server order list (PSOL) to tell NMM which Exchange servers to use to back up the Exchange databases. When the backup starts, NMM backs up the passive or replica copies of each database from the Exchange Servers that are listed in the PSOL parameter. You create the PSOL parameter in the Client Configuration wizard, and the PSOL parameter is associated with a single DAG client resource.

If stand-alone databases (including public folder databases or public folder mailboxes) reside in the DAG, the coordinating node determines whether they exist on that server and, if they do, adds them to the save set list. The coordinating node then goes to another server in the list and repeats the check for passive and stand-alone databases. During this process, the node omits databases that are already listed.

Once the coordinating node has gone through the list of servers, it validates that no databases within the DAG have been left out of the list of save sets. After the coordinating node starts the backup on each of the identified servers.

If you want to exclude stand-alone databases (including public folder databases or public folder mailboxes) from the backup, you must set the **NSR_EXCH_Incl_SA** attribute value to **false**.

Configuring federated backups of a DAG with an IP

You can configure backups of a database availability group (DAG) with an IP (administrative access point) using the Client Backup Configuration wizard or through the Client Properties window.

**Before you begin**

Verify that the NetWorker client resources of the physical DAG nodes are not part of any backup group.

**Procedure**

1. Create a NetWorker client resource for each physical DAG node and the virtual DAG name.

   **Note**

   The physical node client resources should have the Scheduled backup checkbox cleared in the Client Properties window.

2. Specify save set and Application Information attributes and add a backup command under the virtual DAG name.

3. Assign the DAG client resource to the policy.

**Configure a federated backup of a DAG with an IP using the Client Backup Configuration wizard**

This section describes configuring a client resource for a database availability group (DAG) with an IP using the Client Backup Configuration wizard.

**Before you begin**

To use the Client Backup Configuration wizard, you must first install the NMM client on the Exchange server and run the NMM Exchange administration configuration tool.
Note

If you are using NetWorker server 8.2.3 or later and NMM 9.1:

- Configure a regular NetWorker backup group instead of configuring a data protection policy. Do not enable the Snapshot option.

- For the Client Backup Configuration wizard to function properly, ensure that JRE 8 is installed on the system where the NetWorker Management Console (NMC) is used. While the NMC for NetWorker 8.2.3 and later is compiled with JRE 7, the NMM 9.1 Java plugin for NMC is compiled with JRE 8.

- If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x, ensure that the **Block based backup** checkbox is cleared in the client resource. If you do not clear this setting, incremental backups are promoted to level full.

- The procedure that creates a client resource when using NetWorker server 8.2.3 and later is different from the procedure that creates a client resource when using NetWorker server 9.1. Follow the procedure provided in the *EMC NetWorker Module for Microsoft for Exchange VSS User Guide* version 8.2 SP1.

- Before you start the NMM 9.1 Client Backup Configuration wizard to modify a client resource that was created with NMM 8.2.x, ensure that the Snapshot attribute of the NetWorker group that this client resource belongs to is clear. If the Snapshot attribute is selected, you cannot select the NetWorker group in the wizard and you are prompted to create or select another group.

Procedure

1. Open the NetWorker Management Console (NMC) and launch the NetWorker Administration UI.

2. In the left navigation pane of the **Protection** tab, right-click **Clients** and select **New Client Wizard**.

   The following figure shows the initial view of the Client Backup Configuration wizard.
3. On the **Specify Client Information** page:
   a. In the **Client Name** field, type the DAG name.
   b. (Optional) In the **Comment** field, type a description of the client.
   c. (Optional) In the **Tag** field, type one or more tags to identify this client resource for the creation of dynamic client groups for data protection policies. Type each entry on a separate line.
   d. (Optional) In the **Group** field, select a group to assign the client resource to. The group to which the client belongs determines the workflow that is used to back up the client.
   e. In the **Type** box, select **Traditional**.
   f. Click **Next**.

4. On the **Specify the Backup Configuration Type** page, select **Microsoft Exchange Server**, and then click **Next**.

5. On the **Select the NetWorker Client Properties** page, complete the following steps.
   a. Specify the client properties. The following list explains the properties:
      - **Priority**—Enables you to control the order in which the NetWorker server contacts clients for backup.
      - **Parallelism**—Specifies the maximum number of data streams that a client can send simultaneously during a backup operation.
      - **Remote Access**—Specifies a list of users who can access to perform remote access operations.
• **Data Domain Interface**—Specifies the protocol to use if you send the backup data to a Data Domain Device. Available selections are IP, Fiber Channel, or Both.

• **Block based backup (BBB)**—Enables block-based backups for the host. This option is selected by default. You cannot clear this option for Exchange client resources.

• **Client direct**—Enables the client to connect directly to the backup storage device instead of connecting to a NetWorker storage node. This option is selected by default. You cannot clear this option for Exchange client resources.

b. Click **Next**.

6. On the **Select the Exchange Server Objects** page, verify that the databases to back up are selected, and then click **Next**.

   By default, all databases are selected for the entire server backup. Clear the checkbox for any items that must be excluded from the backup.

7. On the **Specify Federated Exchange Backup Options** page:
   a. For federated backup client backup configurations, in the **Database Backup Options** group, select one of the following:
      - **Preferred Passive Backup** to back up passive or replica copies of the databases.
      - **Passive Only Backup** to back up only passive copies or replicas of databases.
      - **Active Only Backup** to back up only active copies of databases.
      - **Use Exclude Component List** to select which databases to exclude from the backup.
   
   — **Note**
   
   When you select **Active Backup** or **Passive Backup**, the backup fails if the selected type of database does not exist.

   The **Database Backup Options** box is not displayed for Exchange stand-alone servers.

   b. For federated backup client backup configurations, in the **Federated Options** group:
      a. Select **Use Preferred Server Order List** to specify the order in which to back up servers.
         By default, the **Use Preferred Server Order List** is selected.
      b. Select a server from the **Available Servers** list, and then click the right arrow to move it to the **Preferred Server List**.
         To adjust the order of servers:
         a. Select a server in the **Preferred Server List**.
         b. Click the up and down arrows to change the order.
      c. Select **Include Standalone and Public Folder databases** to back up stand-alone databases and public folder mailboxes (Exchange Server 2013 and 2016), or public folder databases (Exchange Server 2010).
By default, the **Include Standalone and Public Folder** checkbox is selected.

---

**Note**

The **Include Standalone and Public Folder** option is supported only for federated DAG backup configurations.

---

c. In the **Consistency Check Options** group, enable consistency checks by selecting the **Perform a consistency check during backup** option. Configure the following settings:

   a. Select the **Perform database consistency check during backup** option to validate Exchange databases and logs, databases only, or logs only. In a stand-alone environment, the **Perform database consistency check during backup** option is selected by default. In a DAG environment, performing the database consistency check is optional.

   b. Select the **Sequential consistency check** option to validate the Exchange files sequentially instead of in parallel.

   c. Select the **Throttle Consistency Check** option and then choose the **Throttle I/O Operations** and **Throttle Duration** options to manage the performance of the Consistency Check operation. You can configure the number of consistency check I/O operations to perform before pausing and the length of time to pause between I/O operation cycles.

   d. Click **Next**.

8. On the **Client Configuration Summary** page, review the details and perform one of the following actions:

   - Click **Back** to revisit the previous pages.
   - Click **Create** to configure the client resources.

9. On the **Check Results** page, review the output of the Client Backup Configuration wizard, and click **Finish**.

**Results**

The client resource appears in the **Clients** window pane.
Configure a federated backup of a DAG with an IP using the Client Properties window

This section describes configuring a client resource for a database availability group (DAG) with an IP by using the Client Properties window in the NetWorker Management Console (NMC).

**Note**

The procedure that creates a client resource when using NetWorker server 8.2.3 and later is different from the procedure that creates a client resource when using NetWorker server 9.1. Follow the procedure provided in the *EMC NetWorker Module for Microsoft for Exchange VSS User Guide* version 8.2 SP1. Keep the following considerations in mind when following the NMM 8.2 SP1 procedure:

- Configure a regular NetWorker backup group instead of configuring a data protection policy. Do not enable the Snapshot option.
- If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x, ensure that the Block based backup checkbox is cleared in the client resource. If you do not clear this setting, incremental backups are promoted to level full.
- In the Client Properties window, on the Apps & Modules tab, in the Backup Command field, type `nsrnmmsv.exe`.

**Procedure**

1. In the Administration view of the NetWorker Management Console (NMC), click Protection.
2. In the expanded left pane, select Clients.
3. From the File menu, select New.
4. On the General tab:
   a. In the Name field, type the DAG name.
   b. In the Comment field, type a description.
   c. Ensure that Block based backup is selected.
   d. Determine a list of save sets that must be included in the backup.
   
      To display a list of the application data save sets that are available for backup, open a command prompt on the Exchange server and type the following command.

      ```
      nsrnmmsv -A NSR_FEDERATED_BACKUP=yes -A NSR_EXCH_DAG=<DAG client> -P
      ```

      The following list of save sets is example output from this command:

      "APPLICATIONS:\Microsoft Exchange 2010"
      "APPLICATIONS:\Microsoft Exchange 2010\DB1"
      "APPLICATIONS:\Microsoft Exchange 2010\DB2"

      Before using the following command, use the NMM Exchange administrator configuration tool to create an NMM Exchange administrator account.

      ```
      nsrnmmsv -A NSR_FEDERATED_BACKUP=yes -A NSR_EXCH_DAG=<DAG client> -P
      ```

      The following list of save sets is example output from this command:

      "APPLICATIONS:\Microsoft Exchange 2010"
      "APPLICATIONS:\Microsoft Exchange 2010\DB1"
      "APPLICATIONS:\Microsoft Exchange 2010\DB2"
The output contains all databases in a database availability group (DAG). The `-v` option is not supported for DAGs. Each line of output corresponds to a save set entry that you can add to the save set attribute of a client resource. Type each entry on a separate line.

**Note**

Remove the quotation marks when copying the save set name from the output.

e. In the **Save Set** field, specify the components to be backed up.

The following table provides the Exchange Server 2010 save set syntax for application data.

**Table 13 Exchange Server 2010 save set syntax**

<table>
<thead>
<tr>
<th>Type of backup data</th>
<th>Save set syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writer level</td>
<td>APPLICATIONS:\Microsoft Exchange 2010</td>
</tr>
<tr>
<td>Database name level</td>
<td>APPLICATIONS:\Microsoft Exchange 2010&lt;Database name&gt;</td>
</tr>
</tbody>
</table>

The following table provides the Exchange Server 2013 save set syntax for application data.

**Table 14 Exchange Server 2013 save set syntax**

<table>
<thead>
<tr>
<th>Type of backup data</th>
<th>Save set syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writer level</td>
<td>APPLICATIONS:\Microsoft Exchange 2013</td>
</tr>
<tr>
<td>Database name level</td>
<td>APPLICATIONS:\Microsoft Exchange 2013&lt;Database name&gt;</td>
</tr>
</tbody>
</table>

The following table provides the Exchange Server 2016 save set syntax for application data.

**Table 15 Exchange Server 2016 save set syntax**

<table>
<thead>
<tr>
<th>Type of backup data</th>
<th>Save set syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writer level</td>
<td>APPLICATIONS:\Microsoft Exchange 2016</td>
</tr>
<tr>
<td>Database name level</td>
<td>APPLICATIONS:\Microsoft Exchange 2016&lt;Database name&gt;</td>
</tr>
</tbody>
</table>

When specifying save set names in the **Save Set** field of the client resource, you must specify some special characters, such as the backward slash (`\`), by their URL-encoded values.

The following table lists the most commonly used special characters and their URL values.
Table 16 Special characters and their URL-encoded values

<table>
<thead>
<tr>
<th>Special character</th>
<th>URL-encoded value</th>
<th>Special character</th>
<th>URL-encoded value</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>%5C</td>
<td>?</td>
<td>%3F</td>
</tr>
<tr>
<td>/</td>
<td>%2F</td>
<td>]</td>
<td>%5D</td>
</tr>
<tr>
<td>&quot;</td>
<td>%22</td>
<td>[</td>
<td>%5B</td>
</tr>
<tr>
<td>%</td>
<td>%25</td>
<td>}</td>
<td>%7D</td>
</tr>
<tr>
<td>#</td>
<td>%23</td>
<td>{</td>
<td>%7B</td>
</tr>
<tr>
<td>&amp;</td>
<td>%26</td>
<td>^</td>
<td>%5E</td>
</tr>
<tr>
<td>&lt;</td>
<td>%3C</td>
<td>'</td>
<td>%60</td>
</tr>
<tr>
<td>&gt;</td>
<td>%3E</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

f. In the Protection group list field, select the appropriate option.

5. Click the Apps & Modules tab and do the following:
   a. In the Access area, leave the Remote user and Password fields empty.
   b. In the Backup command field, type the following backup command:
      nsrnmmsv.exe
   c. In the Application Information field, type the required variables and values.
      If you specify more than one Exchange attribute at a time, type each entry and its value on a separate line.

      The following table provides the application variables and values for the Exchange Server environment.

Table 17 Exchange Application Information attribute settings

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
<th>Default and valid values</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSR_EXCH_CHECK=value</td>
<td>Optional. Specifies if a consistency check should be run for databases.</td>
<td>• Yes—Runs a consistency check. This is the default value for Exchange Server stand-alone backups.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• No—Does not run a consistency check.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the value is no, NMM indicates that the consistency check is omitted from the backup log.</td>
</tr>
<tr>
<td>NSR_EXCH_BACKUP=active</td>
<td>Optional. Specifies whether to back up active, passive, preferred, or all of the database copies.</td>
<td>• Preferred (default) — Backs up only a passive copy or replica of each database. If no passive database exists, the active database is backed up.</td>
</tr>
<tr>
<td>/passive/preferred/all</td>
<td></td>
<td>• Active — Backs up only active database copies.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Passive — Backs up only passive database copies.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• All — Backs up both active and passive databases.</td>
</tr>
<tr>
<td>NSR_EXCLUDE_COMPONENTS</td>
<td>Optional. Excludes specified databases from backup</td>
<td>• Undefined (default).</td>
</tr>
<tr>
<td>=db1,db2...</td>
<td></td>
<td>• To exclude databases from the backup, type a comma-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>separated list of their names.</td>
</tr>
</tbody>
</table>
Table 17 Exchange Application Information attribute settings (continued)

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
<th>Default and valid values</th>
</tr>
</thead>
</table>
| NSR_EXCH_INCL_SA | Optional. Includes stand-alone databases, public folder mailboxes (Exchange Server 2013 and 2016), or public folder databases (Exchange Server 2010) in the backup. | • True (default)—Includes stand-alone databases and public folder mailboxes in the backup.  
• False—Excludes stand-alone databases and public folder mailboxes from the backup. |
| NSR_FEDERATED_PSOL | Optional. Specifies the order in which to back up the databases on each server in the DAG. | • Undefined (default)—The coordinating node distributes the backups based on an unordered list of Exchange servers in the DAG.  
• Defined—To define a list, type a comma-separated list of the order in which to back up the databases on each server in the DAG. |
| NSR_USE_CLIENT_SN_LIST | Optional. Specifies to back up each mailbox server in the DAG to a specific storage node, based on what is specified in the Storage Node attribute of each mailbox server client resource. | • No (default)—The storage node is assigned according to the backup policy.  
• Yes—The client resource for the mailbox server where the secondary NMM backup process runs provides the storage node that should be used. |

Table 18 Examples of application variables

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Examples of application variables</th>
</tr>
</thead>
</table>
| Exchange Server DAG backups | • NSR_FEDERATED_BACKUP=<yes>  
• NSR_FEDERATED_PSOL=<DAG Node1>,<DAG node2>,<DAG NodeN>  
• NSR_EXCH_INCL_SA=<TRUE/FALSE>  
• NSR_EXCH_DAG=<DAG FQDN>  
• NSR_EXCH_CHECK=<yes/no>  
• NSR_ESE_UTIL_SEQUENTIAL=<True/False>  
• NSR_ESE_UTIL_THROTTLE=<True/False>  
• NSR_ESE_CC_METHOD=<db_and_logs/db_only/logs_only> |
| Exchange Server federated DAG backups | • NSR_EXCH_DAG=<dagname>  
• NSR_FEDERATED_BACKUP=yes  
• NSR_FEDERATED_PSOL=<List of the order>  
• NSR_EXCH_INCL_SA=<True/False>  
• NSR_EXCH_BACKUP=<active/passive/preferred/all>  
• NSR_EXCLUDE_COMPONENTS=<db1,db2...> |

6. Ensure that Client Direct is enabled.  
Exchange backups require Client Direct.  
7. Click the Globals (1 of 2) tab and verify that the Aliases attribute displays the NETBIOS name for the client.
This name is filled in automatically.

The NMM client uses the host computer NETBIOS or “short” name when it connects to the NetWorker server to browse backups. If the NETBIOS name is not found, NMM does not display backups.

8. If you are using a NetWorker storage node that is different from the NetWorker server, when you configure a client resource for the Exchange Server, click the **Globals (2 of 2)** tab, and in the **Storage node name** field, type the storage node name.

9. Click OK.

10. Create additional client resources for each physical mailbox server in the DAG:
   a. In the **Administration** view of the NMC, click **Protection**.
   b. In the expanded left pane, select **Clients**.
   c. From the **File** menu, select **New**.
   d. In the **Name** field, type the Exchange server name or FQDN.
   e. In the **Comment** field, type a description.
      Use this attribute to differentiate the purpose of the resource for each mailbox server.
   f. In the **Retention Policy** field, select a retention policy from the list.
   g. Confirm that **Scheduled Backups** is selected.
   h. In the **Save Set** field, specify the components that are to be backed up.

### Configuring federated backups of an IP-less DAG

You can configure backups of an IP-less DAG (with no administrative access point) using the Client Backup Configuration wizard or by using the **Client Properties** window.

Consider the following before configuring a backup of an IP-less DAG:

- Exchange 2013 SP1 and later supports IP-less DAG.
- Exchange 2016 defaults to IP-less DAG.
- IP-less DAG requires Windows Server 2012 R2 or later.
- An existing DAG (IP-based) cannot be converted to an IP-less DAG.

#### Configure a federated backup of an IP-less DAG using the Client Backup Configuration wizard

This section describes configuring a client resource for an IP-less database availability group (DAG) by using the Client Backup Configuration wizard.

---

**Note**

For stand-alone databases that are part of an IP-less DAG, use the **Client Properties** window to configure the backup. You cannot use the Client Backup Configuration wizard to configure stand-alone databases in an IP-less DAG.

To use the Client Backup Configuration wizard, first install the NMM client on the Exchange server, and then run the NMM Exchange Admin Configuration tool.
Note

If you are using NetWorker server 8.2.3 or later and NMM 9.1:

- Configure a regular NetWorker backup group instead of configuring a data protection policy. Do not enable the Snapshot option.

- For the Client Backup Configuration wizard to function properly, ensure that JRE 8 is installed on the system where the NetWorker Management Console (NMC) is used. While the NMC for NetWorker 8.2.3 and later is compiled with JRE 7, the NMM 9.1 Java plugin for NMC is compiled with JRE 8.

- If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x, ensure that the **Block based backup** checkbox is cleared in the client resource. If you do not clear this setting, incremental backups are promoted to level full.

- The procedure that creates a client resource when using NetWorker server 8.2.3 and later is different from the procedure that creates a client resource when using NetWorker server 9.1. Follow the procedure provided in the *EMC NetWorker Module for Microsoft for Exchange VSS User Guide* version 8.2 SP1.

- Before you start the NMM 9.1 Client Backup Configuration wizard to modify a client resource that was created with NMM 8.2.x, ensure that the Snapshot attribute of the NetWorker group that this client resource belongs to is clear. If the Snapshot attribute is selected, you cannot select the NetWorker group in the wizard and you are prompted to create or select another group.

Procedure

1. Open the NetWorker Management Console (NMC) and launch the NetWorker Administration UI.

2. In the left navigation pane of the **Protection** tab, right-click **Clients** and select **New Client Wizard**.

   The following figure shows the initial view of the Client Backup Configuration wizard.
3. On the **Specify Client Information** page:
   
   a. In the **Client Name** field, type the FQDN or hostname of a physical server node in the DAG that will be used as the access point.
   
   b. (Optional) In the **Comment** field, type a description of the client.
   
   c. (Optionally) In the **Tag** field, type one or more tags to identify this client resource for the creation of dynamic client groups for data protection policies. Type each entry on a separate line.
   
   d. (Optional) In the **Group** field, select a group to assign the client resource to.
      
      The group to which the client belongs determines the workflow that is used to back up the client.
   
   e. In the **Type** box, select **Traditional**.
   
   f. Click **Next**.

4. On the **Specify the Backup Configuration Type** page, select **Microsoft Exchange Server**, and then click **Next**.

5. On the **Select the NetWorker Client Properties** page, complete the following steps.

   a. Specify the client properties. The following list explains the properties:
      
      - **Priority**—Enables you to control the order in which the NetWorker server contacts clients for backup.
      
      - **Parallelism**—Specifies the maximum number of data streams that a client can send simultaneously during a backup operation.
      
      - **Remote Access**—Specifies a list of users who can access to perform remote access operations.
• **Data Domain Interface**—Specifies the protocol to use if you send the backup data to a Data Domain Device. Available selections are IP, Fiber Channel, or Both.

• **Block based backup (BBB)**—Enables block-based backups for the host. This option is selected by default. You cannot clear this option for Exchange client resources.

• **Client direct**—Enables the client to connect directly to the backup storage device instead of connecting to a NetWorker storage node. This option is selected by default. You cannot clear this option for Exchange client resources.

b. Click **Next**.

6. On the **Select the Exchange Server Objects** page, verify that the databases to back up are selected, and then click **Next**.

By default, all databases are selected for the entire server backup. Clear the checkbox for any items that must be excluded from the backup.

7. On the **Specify Federated Exchange Backup Options** page:

   a. For federated backup client backup configurations, in the **Database Backup Options** group, select one of the following:

      • **Preferred Passive Backup** to back up passive or replica copies of the databases.
          If no replica copy is available or healthy for the database, the active copy is backed up.

      • **Passive Only Backup** to back up only passive copies or replicas of databases.

      • **Active Only Backup** to back up only active copies of databases.

      • **Use Exclude Component List** to select which databases to exclude from the backup.

      **Note**

      When you select **Active Backup** or **Passive Backup**, the backup fails if the selected type of database does not exist.

      The **Database Backup Options** box is not displayed for Exchange stand-alone servers.

b. For federated backup client backup configurations, in the **Federated Options** group:

   a. Select **Use Preferred Server Order List** to specify the order in which to back up servers.

      By default, the **Use Preferred Server Order List** is selected.

   b. Select a server from the **Available Servers** list, and then click the right arrow to move it to the **Preferred Server List**.

      To adjust the order of servers:

      a. Select a server in the **Preferred Server List**.

      b. Click the up and down arrows to change the order.

   c. Select **Include Standalone and Public Folder databases** to back up stand-alone databases and public folder mailboxes (Exchange Server 2013 and 2016), or public folder databases (Exchange Server 2010).
By default, the **Include Standalone and Public Folder** checkbox is selected.

---

**Note**

The **Include Standalone and Public Folder** option is supported only for federated DAG backup configurations.

---

c. In the **Consistency Check Options** group, enable consistency checks by selecting the **Perform a consistency check during backup** option.

Configure the following settings:

a. Select the **Perform database consistency check during backup** option to validate Exchange databases and logs, databases only, or logs only. In a stand-alone environment, the **Perform database consistency check during backup** option is selected by default. In a DAG environment, performing the database consistency check is optional.

b. Select the **Sequential consistency check** option to validate the Exchange files sequentially instead of in parallel.

c. Select the **Throttle Consistency Check** option and then choose the **Throttle I/O Operations** and **Throttle Duration** options to manage the performance of the Consistency Check operation. You can configure the number of consistency check I/O operations to perform before pausing and the length of time to pause between I/O operation cycles.

d. Click **Next**.

8. On the **Client Configuration Summary** page, review the details and perform one of the following actions:

- Click **Back** to revisit the previous pages.
- Click **Create** to configure the client resources.

9. On the **Check Results** page, review the output of the Client Backup Configuration wizard, and click **Finish**.

10. In the NMC, click the **Protection** tab on the **Administration** window.

11. Locate the newly created client in the navigation tree or right-click the client in the **Clients** table, and open the **Client Properties** window.

12. On the **Globals (1 of 2)** tab, in the **Aliases** field, type the DAG name. Include both the short name and full name of the DAG. For example, if **buexch13.net** is the domain name and **DAG2** is the DAG name, type both **DAG2** and **DAG2.buexch13.net**.
This step ensures that NetWorker recognizes that the IP-less DAG name is an alias of the chosen physical mailbox server.

**Note**

After the DAG name is added as an alias to a client, do not remove the alias or add the DAG name to another client resource. If the DAG node that is configured as the client resource is unavailable and you must configure a new client, you are not required to add the DAG name as an alias to the new client.

13. To close the **Client Properties** window, click **OK**.
14. Assign the client resource to a backup group.

**Results**

You can use the client resource to perform federated backups of the IP-less DAG.
Configure a federated backup of an IP-less DAG using the Client Properties window

This section describes configuring a client resource for an IP-less database availability group (DAG) by using the Client Properties window in the NetWorker Management Console (NMC).

**Note**

The procedure that creates a client resource when using NetWorker server 8.2.3 and later is different from the procedure that creates a client resource when using NetWorker server 9.1. Follow the procedure provided in the *EMC NetWorker Module for Microsoft for Exchange VSS User Guide* version 8.2 SP1. Keep the following considerations in mind when following the NMM 8.2 SP1 procedure:

- Configure a regular NetWorker backup group instead of configuring a data protection policy. Do not enable the Snapshot option.
- If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x, ensure that the Block based backup checkbox is cleared in the client resource. If you do not clear this setting, incremental backups are promoted to level full.
- In the Client Properties window, on the Apps & Modules tab, in the Backup Command field, type `nsrnmsv.exe`.

**Procedure**

1. In the Administration view of the NetWorker Management Console (NMC), click Protection.
2. In the expanded left pane, select Clients.
3. From the File menu, select New.
4. In the General tab:
   a. In the Name field, type the FQDN or hostname of a physical server node in the DAG that will be used as the access point.
   b. In the Comment field, type a description.
   c. Ensure that Block based backup is selected.
   d. Determine a list of save sets that must be included in the backup.

To display a list of the application data save sets that are available for backup, open a command prompt on the Exchange server and type the following command. Before using the following command, use the NMM Exchange administrator configuration tool to create an NMM Exchange administrator account.

```
At the command prompt, type the following on any node in the DAG:
```
```
nsrnmsv -A NSR_FEDERATED_BACKUP=yes -A NSR_EXCH_DAG=<DAG client> -P
```

The following list of save sets is example output from this command:
```
“APPLICATIONS:\Microsoft Exchange 2010”
“APPLICATIONS:\Microsoft Exchange 2010\DB1”
“APPLICATIONS:\Microsoft Exchange 2010\DB2”
“APPLICATIONS:\Microsoft Exchange 2010\DB3”
“APPLICATIONS:\Microsoft Exchange 2010\DB4”
```
“APPLICATIONS:\Microsoft Exchange 2010\DB5”

The output contains all databases in a database availability group (DAG). The 
\(-v\) option is not supported for DAGs. Each line of output corresponds to a 
save set entry that you can add to the save set attribute of a client resource. 
Type each entry on a separate line.

**Note**

Remove the quotation marks when copying the save set name from the 
output.

e. In the Save Set field, specify the components to be backed up.

The following table provides the Exchange Server 2010 save set syntax for 
application data.

<table>
<thead>
<tr>
<th>Type of backup data</th>
<th>Save set syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writer level</td>
<td>APPLICATIONS:\Microsoft Exchange 2010</td>
</tr>
<tr>
<td>Database name level</td>
<td>APPLICATIONS:\Microsoft Exchange 2010&lt;Database name&gt;</td>
</tr>
</tbody>
</table>

The following table provides the Exchange Server 2013 save set syntax for 
application data.

<table>
<thead>
<tr>
<th>Type of backup data</th>
<th>Save set syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writer level</td>
<td>APPLICATIONS:\Microsoft Exchange 2013</td>
</tr>
<tr>
<td>Database name level</td>
<td>APPLICATIONS:\Microsoft Exchange 2013&lt;Database name&gt;</td>
</tr>
</tbody>
</table>

The following table provides the Exchange Server 2016 save set syntax for 
application data.

<table>
<thead>
<tr>
<th>Type of backup data</th>
<th>Save set syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writer level</td>
<td>APPLICATIONS:\Microsoft Exchange 2016</td>
</tr>
<tr>
<td>Database name level</td>
<td>APPLICATIONS:\Microsoft Exchange 2016&lt;Database name&gt;</td>
</tr>
</tbody>
</table>

When specifying save set names in the Save Set field of the client resource, 
you must specify some special characters, such as the backward slash (\), 
by their URL-encoded values.

The following table lists the most commonly used special characters and 
their URL values.
Table 22 Special characters and their URL-encoded values

<table>
<thead>
<tr>
<th>Special character</th>
<th>URL-encoded value</th>
<th>Special character</th>
<th>URL-encoded value</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>%5C</td>
<td>?</td>
<td>%3F</td>
</tr>
<tr>
<td>/</td>
<td>%2F</td>
<td>]</td>
<td>%5D</td>
</tr>
<tr>
<td>&quot;</td>
<td>%22</td>
<td>[</td>
<td>%5B</td>
</tr>
<tr>
<td>%</td>
<td>%25</td>
<td>}</td>
<td>%7D</td>
</tr>
<tr>
<td>#</td>
<td>%23</td>
<td>{</td>
<td>%7B</td>
</tr>
<tr>
<td>&amp;</td>
<td>%26</td>
<td>^</td>
<td>%5E</td>
</tr>
<tr>
<td>&lt;</td>
<td>%3C</td>
<td>'</td>
<td>%60</td>
</tr>
<tr>
<td>&gt;</td>
<td>%3E</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

f. Select the appropriate option in the Protection group list field.

5. Click the Apps & Modules tab and perform the following:
   a. In the Access area, leave the Remote user and Password fields empty.
   b. In the Backup command field, type the backup command:
      
      `nsrnmmssv.exe`
      
   c. In the Application Information field, type the required variables and values. If you specify more than one Exchange attribute at a time, type each entry and its value on a separate line.

The following table provides the application variables and values for the Exchange Server environment.

Table 23 Exchange Application Information attribute settings

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
<th>Default and valid values</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSR_EXCH_CHECK=value</td>
<td>Optional. Specifies if a consistency check should be run for databases.</td>
<td>• Yes—Runs a consistency check. &lt;br&gt;• No—Does not run a consistency check. This is the default value for Exchange Server DAG backups. &lt;br&gt; If the value is no, NMM indicates that the consistency check is omitted in the backup log.</td>
</tr>
<tr>
<td>NSR_EXCH_DAG=&lt;DAG name&gt;</td>
<td>Optional. Specifies the DAG name for a backup in a DAG environment.</td>
<td>• Undefined (default). &lt;br&gt;• FQDN of the DAG. &lt;br&gt;For example, NSR_EXCH_DAG=mydag.domainname.com</td>
</tr>
<tr>
<td>NSR_EXCH_BACKUP=active/passive/preferred/all</td>
<td>Optional. Specifies whether to back up active, passive, preferred, or all the database copies. The default setting is preferred.</td>
<td>• Preferred (default)—Backs up only passive copy or replica of each database if one is available. If no passive database exists, then the active database is backed up. &lt;br&gt;• Active—Backs up only active database copies. &lt;br&gt;• Passive—Backs up only passive database copies. &lt;br&gt;• All—Backs up both active and passive databases.</td>
</tr>
</tbody>
</table>
Table 23 Exchange Application Information attribute settings (continued)

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
<th>Default and valid values</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSR_EXCLUDE_COMPONENTS db1, db2</td>
<td>Optional. Excludes specified databases from backup.</td>
<td>• Undefined (default).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To exclude databases, type a comma-separated list of the database names to exclude from the backup.</td>
</tr>
<tr>
<td>NSR_EXCH_INCL_SA</td>
<td>Optional. Includes stand-alone databases and public folder mailboxes (Exchange Server 2013 and 2016), or public folder databases (Exchange Server 2010) in the backup.</td>
<td>• True (default)—Includes stand-alone databases and public folder mailboxes in the backup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• False—Excludes stand-alone databases and public folder mailboxes from the backup.</td>
</tr>
<tr>
<td>NSR_FEDERATED_PSOL</td>
<td>Optional. Specifies a list of the order in which to back up the databases on each server in the DAG.</td>
<td>• Undefined (default)—The coordinating node distributes the backups based on an unordered list of Exchange servers in the DAG.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Defined—to define a list, type a comma-separated list of the order in which to back up the databases on each server in the DAG.</td>
</tr>
<tr>
<td>NSR_USE_CLIENT_SN_LIST</td>
<td>Optional. Specifies to backup each mailbox server in the DAG to a specific storage node, based on what is specified in the Storage Node attribute of each mailbox server client resource.</td>
<td>• No (default)—The storage node is assigned according to the backup policy.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Yes—The storage node used is obtained from the client resource for the mailbox server where the secondary NMM backup process is run.</td>
</tr>
</tbody>
</table>

Table 24 Examples for application variables

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Examples for application variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange Server DAG backups</td>
<td>• NSR_FEDERATED_BACKUP=&lt;yes&gt;</td>
</tr>
<tr>
<td></td>
<td>• NSR_FEDERATED_PSOL=&lt;DAG Node1&gt;,&lt;DAG node2&gt;,&lt;DAG NodeN&gt;</td>
</tr>
<tr>
<td></td>
<td>• NSR_EXCH_INCL_SA=&lt;TRUE/FALSE&gt;</td>
</tr>
<tr>
<td></td>
<td>• NSR_EXCH_DAG=&lt;DAG FQDN&gt;</td>
</tr>
<tr>
<td></td>
<td>• NSR_EXCH_CHECK=&lt;yes/no&gt;</td>
</tr>
<tr>
<td></td>
<td>• NSR_ESE_UTIL_SEQUENTIAL=&lt;True/False&gt;</td>
</tr>
<tr>
<td></td>
<td>• NSR_ESE_UTIL_THROTTLE=&lt;True/False&gt;</td>
</tr>
<tr>
<td></td>
<td>• NSR_ESE_CC_METHOD=&lt;db_and_logs/db_only/logs_only&gt;</td>
</tr>
<tr>
<td>Exchange Server federated DAG backups</td>
<td>• NSR_EXCH_DAG=&lt;dagname&gt;</td>
</tr>
<tr>
<td></td>
<td>• NSR_FEDERATED_BACKUP=yes</td>
</tr>
<tr>
<td></td>
<td>• NSR_FEDERATED_PSOL=&lt;List of the order&gt;</td>
</tr>
<tr>
<td></td>
<td>• NSR_EXCH_INCL_SA=&lt;True/False&gt;</td>
</tr>
<tr>
<td></td>
<td>• NSR_EXCH_BACKUP=&lt;active/passive/preferred/all&gt;</td>
</tr>
</tbody>
</table>
Table 24 Examples for application variables (continued)

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Examples for application variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>nsr_exclude_components</td>
<td>&lt;db1,db2… &gt;</td>
</tr>
</tbody>
</table>

6. Ensure that **Client Direct** is enabled.

   Exchange backups require Client Direct.

7. Click the **Globals (1 of 2)** tab and verify that the **Aliases** attribute displays the NETBIOS name for the client.

   This name is filled in automatically.

   The NMM client uses the host computer NETBIOS or “short” name when it connects to the NetWorker server to browse backups. If the NETBIOS name is not found, NMM does not display backups.

8. On the **Globals (1 of 2)** tab, in the **Aliases** field, type the DAG name.

   Include both the short name and full name of the DAG. For example, if buexch13.net is the domain name and DAG2 is the DAG name, type both **DAG2** and **DAG2.buexch13.net**.

   **Figure 9** Adding the DAG name as an alias to a client resource

   This step ensures that NetWorker recognizes that the IP-less DAG name is an alias of the chosen physical mailbox server.

   **Note**

   Once the DAG name is added as an alias to a client, do not remove the alias or add the DAG name to another client resource. If the DAG node configured as the client resource is unavailable and you must configure a new client, you are not required to add the DAG name as an alias to the new client.
9. If you are using a NetWorker storage node that is different from the NetWorker server, when you configure a client resource for the Exchange Server, click the **Globals (2 of 2)** tab, and in the **Storage node name** field, type the storage node name.

10. Click **OK**.

11. Create additional client resources for each physical mailbox server in the DAG:
   a. In the **Administration** view of the NetWorker Management Console, click the **Protection** tab.
   
   b. In the expanded left pane, select **Clients**.
   
   c. From the **File** menu, select **New**.
   
   d. In the **Name** field, type the Exchange server name or FQDN.
   
   e. In the **Comment** field, type a description.

   Use this attribute to differentiate the purpose of the resource for each mailbox server.

   f. For the **Retention Policy** field, select a retention policy from the list.
   
   g. Confirm that the **Scheduled Backups** field is selected.
   
   h. In the **Save Set** field, specify the components to be backed up.

Reconfiguring an IP-less DAG backup to a different node

If the DAG node that is configured as the client resource is unavailable, the backup fails and you must configure a new client resource. If you are reconfiguring an IP-less DAG client resource, you must follow additional steps.

**Procedure**

1. Reconfigure a new client resource from an available physical mailbox server within the DAG.

2. Remove the old DAG client resource from the backup group.

3. Add the new DAG client resource to the backup group.

**Note**

Do not delete the old client resource. Do not remove the DAG alias from the old client resource.

Configuring backups to use a remote storage node in a DAG environment

This topic describes the steps for configuring remote storage in an Exchange database availability group (DAG) environment. This procedure allows you to specify a storage
node for the physical clients in the DAG, which can differ from the storage node defined in the federated backup policy.

**Note**

If you are using NetWorker server 8.2.3 or later and NMM 9.1:

- Configure a regular NetWorker backup group instead of configuring a data protection policy. Do not enable the Snapshot option.
- If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x, ensure that the **Block based backup** checkbox is cleared in the client resource. If you do not clear this setting, incremental backups are promoted to level full.
- This procedure that creates a client resource when using NetWorker server 8.2.3 and later is different from the procedure used to create a client resource when using NetWorker server 9.1. Follow the procedure provided in the "Configuring backups to use a remote storage node in a DAG environment" section in the *EMC NetWorker Module for Microsoft for Exchange Server VSS User Guide* release 8.2 SP1 when using NetWorker server 8.2.3.

**Procedure**

1. **On each mailbox server that you want to back up, install the NetWorker client software with the Storage Node option.**
2. **Open the NMC and create a storage node for each client:**
   a. On the **Devices** tab, right-click **Storage Nodes** and select **New**.
   b. Type the name of the client. For example, node1.domain.com.
   c. Right-click **Devices**, select **New**, and create the device for the storage node.
   d. Label and mount the storage node device.
3. **Configure the client to use the storage node:**
   a. Right-click **Client** and select **Modify client**.
   b. On the **Globals (2 of 2)** tab, in the **Storage Nodes** field, type the storage node name. For example, node1.domain.com.
4. **For federated backups, also perform the following steps:**
   a. In the **Client Properties** window of each DAG client resource, in the **Application Information** field, type **NSR_USE_CLIENT_SN_LIST=yes**.
   b. Add the client resources for each physical node to the same group as the DAG client.
   c. In the client resources for each physical node, clear the **Scheduled Backup** checkbox.
   d. In the **Globals (2 of 2)** tab, in the **Storage node name** field, type a name in the client resources for each physical node.
   e. In the data protection policy for the federated backup, ensure that the selected pool contains the storage node being used for backup.
5. **Run the backup and verify that NMM saves the backup to the remote storage node.**
Example of a federated backup

The following figure illustrates a federated backup of a database availability group (DAG) cluster with three Exchange Servers: MBX1, MBX2, and MBX3. The cluster contains four Exchange databases: DB1, DB2, DB3, and DB4. Each database can have only one active copy, but the database can have multiple passive or replica copies. In this example, there are two passive copies of DB1: one copy is on two different Exchange Servers (MBX2 and MBX3). Each of the other databases (DB2, DB3, and DB4) have only one passive copy in the cluster. Only one copy of each database must be backed up. The preferred server order list specifies that the databases from the DAG must be backed up in this order: MBX2, MBX3, and MBX1.

Figure 10 Example of an Exchange Server federated backup

Configuring NetWorker privileges manually

NMM requires that user groups have specific privileges to perform certain operations.

Table 25 User group privileges for NMM operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Required user group privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>Federated backup</td>
<td>Operate NetWorker</td>
</tr>
</tbody>
</table>
Table 25 User group privileges for NMM operations (continued)

<table>
<thead>
<tr>
<th>Operation</th>
<th>Required user group privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup deletion</td>
<td>Changed Application Settings</td>
</tr>
</tbody>
</table>

Complete the following steps to configure NetWorker user group privileges manually.

**Procedure**

1. Open the NetWorker Administration GUI.
2. Click **Server**.
3. In the expanded left pane, click **User Groups**.
4. Right-click the appropriate user group, and then select **Properties**.
   The **Properties** dialog box appears.
5. In the **Users** field, add the following values for the NMM client host. Type each value on a separate line:
   
   ```
   user=NMM_Exchange_backup_admin_user, host=NMM_client_host
   user=system, host=NMM_client_host
   ```
   
   where **NMM_client_host** is the DNS hostname of the NMM client.
6. Click **OK**.
7. Configure the user group privilege as described in the application-specific user guides.

**Modifying a client resource after upgrading from NMM version 8.2.x or earlier**

After updating NMM from an earlier version, you can modify a client resource using the **Client Properties** window.

**Note**

You can also edit a client resource using the Client Backup Configuration wizard. When you use the Client Backup Configuration wizard to update an NMM 8.2.x backup configuration for the first time, you must configure a new backup group and remove the existing backup group.

**Procedure**

1. Open NMC and launch the EMC NetWorker Administration UI.
2. In the **Administration** window, click **Protection**.
3. From the navigation tree, select **Clients**, or in the **Clients** table, right-click the required client name.
4. In the **Client Properties** window, click the **Apps & Modules** tab.
5. Select **Modify Client Properties**.
6. In the **Backup Command** field, delete the **nsrsnap_vss_save** command and type the **nsrnmmsv.exe** command. This change must be performed for all the existing client resources.
7. In the **Application Information** field, make the following changes:
   
   - If the optional **NSR_EXCH2010_BACKUP** attribute is set, perform one of the following:
     
     - Delete the **NSR_EXCH2010_BACKUP** entry. NMM will use the preferred default setting to back up database copies.
     
     - Replace the entry with **NSR_EXCH_BACKUP=active/passive/preferred or all**.

   - If the optional **NSR_EXCH_2010_DAG** attribute is set, replace it with **NSR_EXCH_DAG= <DAG_name>**.

   The **NSR_EXCH2010_BACKUP** and **NSR_EXCH_2010_DAG** attributes are no longer supported. If either attribute is specified, the backup will fail.

8. If required, make other changes.

9. Click **OK**.

**Verifying a backup**

To verify that a backup is successful, at a command prompt on the NetWorker client, type the following:

```
mminfo -Sot -s NW server -c NMM client
```

where:

- **NW server** is the name of the NetWorker server.
- **NMM client** is the database availability group (DAG) name or Exchange Server mailbox server name.
CHAPTER 4

Mail Item Recovery

This chapter includes the following sections:

- **Overview** ........................................................................................................... 72
- **Exchange recovery prerequisites** ..................................................................... 78
- **Configuring Exchange Server recovery operations** ..................................... 79
- **Recovery procedures** ........................................................................................ 81
- **Best practices and recommendations for Exchange backup and recovery operations** ............................................. 93
Overview

An Exchange recovery can serve many different purposes. The most granular backup is of an Exchange database, its log files, and its checkpoint files. Those backups can be used to recover entire servers, individual databases, or mailbox items.

When you use NMM to back up a Microsoft Exchange Server environment, the following recovery options are available for stand-alone and high-availability environments:

- Recover to the original location on the original Exchange server
- Recover to the Exchange Server recovery database (RDB) on the original Exchange Server
- Recover to an Exchange Server RDB on a different Exchange Server
- Granular-level recoveries for individual mail items and folders

The Granular-Level Recovery chapter and the EMC ItemPoint for Microsoft Exchange Server User Guide provide information about how to perform granular-level recoveries.

Recovery types

NMM provides many levels of recovery. For example, you can recover a complete database or an individual message in a user mailbox.

Database-level recovery

When you recover a database, you generally overwrite the current database unless you recover to a recovery database (RDB). See Recovering Exchange Server mailbox, public folder database, or public folder mailbox files on page 91.

Message-level and granular-level recovery

When you must retrieve individual user mailboxes, user mail folders, or messages, you can do so without overwriting entire mail databases. There are multiple methods you can use to recover individual mail items. You can mount a database, then browse and mark items for recovery using EMC ItemPoint for Microsoft Exchange Server. You can also recover a database to an Exchange recovery database (RDB), and then use NMM GUI to select and recover individual mailboxes, folders, or messages. The Granular-Level Recovery Chapter provides the recovery procedures.

DAG recovery

A database availability group (DAG) backup provides access to backups of all Exchange databases through one NMM client, although the backups come from multiple Exchange Servers in the DAG. You perform the recovery to the Exchange Server that is hosting the active database copy. The DAG backup recovery process is the same as the normal DAG recovery process.

Public mailbox folder and database recovery

You can recover public folder mailboxes (Exchange Server 2013 and 2016) and public folder databases (Exchange Server 2010) just as you would any other mailbox database.
Recovering an Exchange database

This topic provides an overview of a stand-alone Exchange database recovery.

In a simple Exchange recovery, entire databases are replaced or recovered. When you recover entire databases, the recovery operation overwrites the current content at the original location with the recovered data.

The following figure illustrates a simple recovery of the Exchange databases in a stand-alone Exchange Server environment.

Figure 11 Recovery in a stand-alone Exchange Server environment

In a stand-alone environment, if you do not want to overwrite the current content, you can recover data to an alternate mailbox database on the same Exchange Server, or you can recover the recovery database (RDB) and granular-level recovery (GLR) data to a different Exchange Server. Use the NMM GUI to browse mail folders and locate individual messages.
Recovering individual mailboxes, mailbox folders, and messages

Retrieving and restoring large backups can use significant network, memory, processor, and storage resources. Depending on the topology and architecture that a site or organization uses, the recovery operations might also affect production server performance, which can impact mail users.

NMM provides several methods for recovering individual items, such as user mailboxes, mailbox folders, and messages, within an Exchange database. These methods offer several advantages over full-Exchange Server or database recovery:

- You can recover backup data to an alternate location without overwriting the existing databases or servers.
- You can browse and select individual items from the recovered data, and then recover the items to the individual’s mailbox.

With NMM, you can recover individual items using one of the following methods:

- Granular-level recovery (GLR)—NMM mounts the backup set to a virtual drive, where you can browse the backup content without actually moving or copying the data. NMM creates this virtual drive quickly and does not require significant disk storage space. You can browse and select the data, down to the message level, from this virtual drive, as if you were viewing the actual database. Only when you send the recovery request to the NetWorker server are items copied from the backup set to a new Recovered items folder in the user’s mailbox. You can browse and select which items to keep, just like any other folder in a mailbox. GLR saves time and resources by retrieving only the selected items, rather than entire databases.
- Recover to a recovery database (RDB)—You can also recover databases to an RDB, and then browse those databases to select mailboxes, user folders, or messages for recovery. When you restore to an RDB, you can browse the database offline, on a separate server, or from a folder that is separate from the online production Exchange server. While this method allows you to browse and retrieve items without overwriting the live Exchange databases or user mailbox, recovery to an RDB requires disk space, network resources, and processor resources to stage the databases in the RDB. When you recover to an RDB, it takes time to copy data from one location to another. NMM recovers the backup to the RDB, then you can browse and retrieve individual items.

Compare the following figures, which illustrate:

- Recover using NMM granular-level recovery.
- Recover to an RDB, and recover data from the RDB to a user mailbox.
Figure 13 Recover using NMM granular-level recovery

1. View and select the backup save set to restore.
2. Select the storage group or database from which to recover.
3. NetWorker mounts the selected storage group or database to a virtual drive.
4. Browse and select the user, mail folder, or message to recover.
5. **Restore** operation sends restore request to the NetWorker server.
6. The NetWorker server sends actual items to Exchange server.
7. NetWorker places restored items in a new folder in user's mailbox, named "Recovered Items DATE_AND_TIME"
Figure 14 Recover to an RDB, and then recover data from the RDB to a user mailbox

1. View and select the backup save set to restore.

2. Create RDB automatically in NetWorker restore options, or manually before restore with Exchange management tools.

3. Restore storage group or database backup to RDB.

4. Use the NMM GUI to restore user mailbox, folders or messages to a target mailbox or archive mailbox.

-OR-
An RDB can be used only for recovering mailbox database data. It cannot be used to recover public folders.

Exchange recovery prerequisites

Certain prerequisites must be met before you recover Exchange Server data with NMM:

- Verify that the correct version of the Messaging API (MAPI) and Collaboration Data Objects (CDO) kit is installed. Exchange Server requirements for MAPI client and collaboration data objects on page 32 provides details.
- If you want to restore an Exchange database to its original location, you must select This database can be overwritten by a restore in the Exchange Management Console. In PowerShell, the flag is called Get-MailboxDatabase -Identity <DATABASE NAME>|select AllowFileRestore. The Microsoft Exchange documentation provides more information about this requirement.
- When creating a recovery database (RDB), do not use symbols in the folder name. RDB item-level recovery fails with an error if the folder name contains a symbol. For example, the folder name that is used is “Recovered Data - sec77 - 04/03/2013 18:28:45”.
- Exchange does not support restoring public folder mailboxes (Exchange Server 2013 and 2016), or public folder databases (Exchange Server 2010) to RDBs.
- During recovery, when you recover mailbox items to a production database, ensure that the user mailbox is not full. If the allotted mailbox space is exceeded, the item-level recovery fails.
- When you overwrite existing databases with recovered databases, perform a full-level backup after every recovery that is performed in Exchange Server. This action does not apply to RDB or GLR operations.

Requirements for browsing mailboxes

Ensure that the mailbox that you want to browse meets the following requirements:

- Databases must be online. NMM does not display mailboxes in offline databases.
- For Exchange Server 2010 and 2013, the MAPI/CDO 1.21 kit must be installed.
- Exchange System Attendant and Information Store services must be running.
- Log in with the user you created with the NMM Exchange Admin Configuration tool. The logged-in user must have a configured mailbox with at least one sent or received message.
- You must have backed up the writer set or database save set:
  - For Exchange Server 2010:
    Writer: APPLICATIONS:\Microsoft Exchange 2010
    Database: APPLICATIONS:\Microsoft Exchange 2010\Database
  - For Exchange Server 2013:
    Writer: APPLICATIONS:\Microsoft Exchange 2013
Requirements for recovering databases in a DAG

For database availability group (DAG) recovery to the original database, ensure that the database recovery node and state are correct. You must perform the recovery to the DAG member server on an active node. The restored databases must be in active state. Passive copies of the databases must be in Exchange replication suspended state. If these copies are not in suspended state, you must manually suspend replication copies before you perform a recovery.

You can suspend replication in the following three ways:

- Use the Exchange Shell command and call the **Suspend-MailboxDatabaseCopy** cmdlet
- For Exchange Server 2010, through the Exchange Management Console, in the **Database Copies** tab, click **Suspend Database Copy**
- For Exchange Server 2013 and 2016, through the Exchange Admin Center, in the **Details** pane, under **Database Copies**, click **Suspend**

Resume the passive database copies after the restore. The Microsoft documentation provides further details.

Configuring Exchange Server recovery operations

This section provides the procedures for configuring an Exchange Server recovery.

Specifying Exchange recovery options

**Procedure**

1. Open the NMM client user interface.
2. Select the **NetWorker Server** on which the NMM client software was configured for backup.
3. If the NMM client is part of a cluster, select the virtual client to which you are recovering data. You can select the virtual client from the client list in the application toolbar.
4. From the left pane, select **Exchange 2010 Recover Session**, **Exchange 2013 Recover Session**, or **Exchange 2016 Recover Session**, and then select one of the following:
   - **Database Recovery** to view Exchange database backups and recover to recovery database (RDB) and perform either in-place recovery or alternate recovery from database backups. This is the default option for Exchange Server 2010 and 2013 and the only option for Exchange Server 2016.
   - **RDB Mailbox Recover** to browse and recover mailbox items from an existing RDB.
   - **Granular Level Recover** to browse and recover items from databases without restoring the database to an RDB.
5. In the **Exchange Server Session** toolbar, click **Recover Options**.
6. Select the type of recovery to perform:
   - To recover data for Exchange Server and retain all existing Exchange transactions that occurred after the time of backup, select **Include existing logs (Roll forward recovery)**.
   - To recover data for Exchange Server up to the time of backup only, select **Include logs only from this restore (Point-in-time recovery)**. After performing a point-in-time recovery, roll-forward recovery cannot be performed because the point-in-time recovery replaces the logs that were generated after the backup.
   - To mount the database after the restore operation, select **Put database online after restore**.
   - To recover the database and transaction logs from the backup without replaying the transaction logs, select **Do not replay the transaction logs**. The database cannot be mounted after the restore operation. If you select this option, you must manually replay the transaction logs by running the Exchange `eseutil.exe` utility.
   - To specify the number of retries when trying to mount the database, select a number from the **Number of attempts to try before failing on mount** list.
   - To recover deleted files on the filesystem, select **Restore Deleted Database Files on Filesystem**.

7. Click **OK** to close the Exchange Recover Options dialog box.

8. From the navigation tree, expand the **Microsoft Exchange 2010**, **Microsoft Exchange 2013**, or **Microsoft Exchange 2016** folder.

9. Select the Exchange databases that you want to recover.

10. From the **Exchange 2010 Recover Session**, **Exchange 2013 Recover Session**, or **Exchange 2016 Recover Session** toolbar, click **Recover**.

## Configuring roll-forward recovery of an Exchange server in a DAG environment

**NOTICE**

Perform the recovery from the node where the recovered database is active.

### Procedure

1. To identify the Exchange database that must be recovered, use the Exchange Management Console (EMC), the Exchange Administrative Console (EAC), or a shell script to determine the database availability group (DAG) member where the active copy of the database resides.

   The topic [Requirements for recovering databases in a DAG](#) on page 79 provides additional details.

2. In the EMC or EAC application, select **This database can be overwritten by a restore**.

3. In the Exchange Management shell, stop replication of any passive copies of the database with the `suspend-MailboxDatabaseCopy` command.

   For example:
   ```
   Suspend-MailboxDatabaseCopy -Identity "bv-e15svr1\First Database"
   ```
The topic Requirements for recovering databases in a DAG on page 79 provides additional details.

4. Open the NMM client.
5. Select the NetWorker Server on which the NMM client software was configured for backup.
6. On the main toolbar, select the **Client** list, and then select the Exchange DAG client.
7. From the left pane, select **Recover**.
8. Select **Exchange Recover**, and then select **Database Recovery** to view Exchange database backups.
9. Click **View**, and then click **Refresh**.
10. From the navigation tree, expand the Microsoft Exchange folder.
11. Select the Exchange Server items that you want to restore.
    You can select more than one database for recovery. You can select backups of active or passive databases for recovery.
12. From the **Exchange Recover Session** toolbar, click **Recover**.
    The **Exchange Recovery Options Summary** dialog box appears.
13. Review the options:
    - If you must change the options, click **Recover Options**. This action opens the **Exchange Recover Options** dialog box, where you can change settings on the **General**, **NetWorker**, **Security**, and **Exchange** tabs.
    - If the summary does not indicate a roll-forward recovery, click **Recover Options**, go to the **Exchange** tab, and in the **Transaction Log File Replay** dialog box, verify that **Include existing logs (Roll-forward recovery)** is selected. This default setting might have changed if the previous recovery was a point-in-time recovery.
    - If the options are okay, click **Start Recover**. This action closes the **Exchange Recover Options** dialog box and starts the recovery.
14. Click **Restore**.
15. After the restore operation completes, restore replication between the nodes with the **resume-MailboxDatabaseCopy** command.
    For example:
    ```bash
    resume-MailboxDatabaseCopy -Identity "bv-hood-e15svr1\First Database"
    ```
    **NOTICE**
    Perform a full backup after performing a roll-forward recovery.

---

## Recovery procedures

The following topics describe the procedures to perform a recovery using NMM.
Viewing volumes to back up for recovery

To view the volumes that you must back up to recover Exchange server data, use the NMM GUI to perform either of the following steps:

- Right-click the Exchange Writer-level save set for which you want to view the volumes, and select **Required volumes**. The **Required NetWorker Volumes** dialog box with details about the volume appears.
- Select any of the backed-up databases and click **Required volumes**. The **Required NetWorker Volumes** dialog box with details about the volume appears.

Recovering NetWorker Module for Microsoft Exchange backups

NetWorker Module for Microsoft Exchange (NME) and NMM cannot be installed on the same client. NME and NMM use some of the same binaries for item-level browsing and recovery, so running both NME and NMM on the same client causes versioning conflicts for the common binaries.

**Procedure**

1. Uninstall NMM. Leave the NetWorker client software running.
2. Install NME.
3. Recover the NME data.
4. Uninstall NME.
5. Reinstall NMM.

Mounting the database after recovery

Certain Exchange pre-restore and post-restore operations enable quick access to email after recovery. However, until you remount Exchange databases, users cannot browse and verify email messages. NMM provides options to automatically remount Exchange databases after restore.

The Exchange administrator decides whether a restore of a particular Exchange database is required and if an automatic mounting of the database must be done after the restore is complete. Consider the following points about automatic mounting:

- If automatic mounting is enabled, the database is mounted after the successful restore of the Exchange Server.
- If automatic mounting is disabled, the administrator must manually mount the database.

Performing Exchange Server recovery

This section provides information on performing an Exchange Server recovery.

Performing a full recovery

You can recover the contents of a backed-up database to the original database by performing full recovery.

**Procedure**

1. In the NMM user interface, select the NMM client.
2. Click **Recover > Exchange Recover Session**, and then select one of the following:

- **Database Recovery** (default) — Select to view Exchange database backups.
- **RDB Mailbox Recover** — Select to browse and recover Exchange Server items from an existing recovery database (RDB).
- **Granular Level Recover** — Select to browse and recover items from databases without having to first restore the database to an RDB.

3. If no databases appear, click **View > Refresh**.

4. In the NMM user interface, select the database.

5. If the database is not listed, specify a browse time that includes the required backup.

The *EMC NetWorker Administration Guide* provides details.

6. From the taskbar, click **Recover**.

**NOTICE**

Always perform a full backup after performing a point-in-time or roll-forward recovery.

**Performing an advanced recovery**

In the NMM user interface, select the NMM client and then select **Recover > Exchange Recover Session > Database Recovery (default) > Advanced Recover** to recover a database to one of the following locations:

- A selected recovery database (RDB) — Exchange Server 2010 Service Pack 1 Rollup 6 or later, Exchange Server 2013, and Exchange Server 2016 support the ability to restore data directly to an RDB. Mounting the recovered data as an RDB allows you to restore individual mailboxes or individual items in a mailbox.

  Public folders for Exchange 2010 cannot be recovered to an RDB. Public folders for Exchange 2013 and 2016 are part of the mailbox database, and thus can be recovered to RDB.

- An alternate database that is mounted on the mailbox server.

- A remote database — In remote database recovery, a selected mailbox database is restored to a remote mailbox server in the Exchange database availability group (DAG) where the active database resides.

  The remote database recovery option is available only for Exchange Server DAGs. Alternate and remote recoveries are supported only in the same domain.

**Performing a DAG database recovery**

**Procedure**

1. Identify the Exchange database that must be recovered:
   
   a. Use the Exchange Management Console (EMC), the Exchange Administrative Console (EAC), or a shell script to determine the DAG member where the active copy of the database resides.

   b. Log in to the Exchange Server node that is running the active copy of the database that is to be recovered.
c. If you are recovering to the original database location, open the database properties and select **This database can be overwritten by a restore**.

2. Suspend all passive copies of the database that are to be recovered.

   The topic **Additional requirements for recovering databases in a DAG** provides details.

3. In the NMM user interface, select the NMM client and then select **Recover > Exchange Recover Session > Database Recovery (default)**.

4. Select the DAG for recovery:
   - To recover normal DAG backups—Select the DAG name for the client on which the NMM client software was configured for backup.
   - To recover IP-less DAG backups—Select the hostname of the physical mailbox server in the DAG for the client on which the NMM client software was configured for backup.

5. Select the DAG database to be recovered.

   **Note**

   If no databases appear, click **View > Refresh**.

6. Click **Advanced Recover**.

   The **Advanced Recovery** dialog box appears. The **Steps** group lists the three steps for recovery:

   - Select Recovery
   - Select DB & Server
   - Summary

   **Figure 15** Advanced Recovery dialog box

   Click **Recover Options** to skip the steps for Advanced Recovery and perform full recovery of the database displayed in **Database (Source)**.

7. In the **Advanced Recovery** dialog box, under **Recovery Type**, complete the required steps for the recovery type that you need to perform:

   - **Recovery Database (RDB) Recovery**—To recover to an RDB, perform the following steps:
     a. Select **Recovery Database (RDB) Recovery**, and then click **Next**.
     b. In the **Recovery Database (RDB) Recovery List** group, to create an RDB, click **Create**.

   The **Create RDB** dialog box appears.
c. In the RDB Name field, type a name for the new RDB.

d. In the EBD File Path field, browse and select the file path location for the new RDB.

e. In the Log File Path field, browse and select the location for the log file.

f. Click Create.

The new RDB is created and appears in the Manage RDB dialog box.

g. Select the created RDB, and then click Next.

- **Alternate Database Recovery**—To recover to an alternate database, perform the following steps:

  a. Select Alternate Database Recovery, and then click Next.
  
b. Select the database that you want to recover to, and then click Next

- **Remote Database Recovery**—To recover to a remote database, perform the following steps:

  a. Select Remote Database Recovery, and then click Next.

  The Select Server dialog box appears with a list of remote databases.

  b. Select the database to which you want to perform the recovery, and then click Next.

The Exchange Recovery Summary dialog box appears. This dialog box lists the Exchange Server Recovery options and the NetWorker Recovery Options. It also allows you to review the recovery details before you continue.

Figure 16: Exchange Recovery Summary dialog box

8. To continue with recovery, click Start Recovery.

Recovering to a recovery database (RDB)

RDB recovery is possible only when Exchange 2010 Service Pack 1, Rollup 6, or a later version of Exchange Server is installed. The following recovery configurations are possible:

- An RDB can be created and recovered on a DAG member server that has either a passive or active copy of the database.
- An RDB recovery can be done from any DAG node for any DAG Mailbox databases.
- An RDB recovery can be performed from another mailbox server that is not part of the DAG but is part of the same Exchange organization.

In a multitenant environment, an administrator is created for each tenant. But when the user logs in as a domain administrator and performs RDB browsing, there is a
conflict in names due to existence of more than one administrator. To work around this issue, create a user (for example, NMMBackupUser) and add this user as member of the Organization Management group to each of the tenants.

RDB browsing fails if the user credentials that are used for the operation have an alias in the Active Directory. In this situation, you must create a user (without an alias) and install NMM with the credentials of the new user. Provide the necessary permissions and use the user account for RDB browsing operations.

Procedure

1. In the NMM user interface, select the NMM client and then select Recover > Exchange Recover Session > Database Recovery (default) > Advanced Recover.
2. In the Advanced Recovery dialog box, select Recovery Database (RDB) Recovery, and then click Next.
3. In the Manage RDB dialog box, as shown in the following figure.

Figure 17 Manage RDB dialog box

4. In the Recovery Database (RDB) Recovery List group, to create an RDB, click Create.
   
   The Create RDB dialog box appears.

Figure 18 Create RDB dialog box

5. In the RDB Name field, type a name for the new RDB.
6. In the EBD File Path field, browse and select the file path location for the new RDB.
7. In the Log File Path field, browse and select the location for the log file. 
   
   Previously, due to a Microsoft requirement, the Exchange Server 2010 database logs path and Mailbox databases that reside on the same volume could not be stored in the same file path location. This restriction has been lifted.
7. Click **Create**.
   The new RDB is created and appears in the **Manage RDB** dialog box, in the **Recovery Database (RDB) List**.

8. Select the created RDB and click **Next**.
   The **Exchange Recovery Summary** dialog box appears. This dialog box lists the Exchange Server Recovery options and the NetWorker Recovery Options. It also allows you to review the recovery details before you continue.

9. To continue with recovery, click **Start Recovery**.

### Recovering to an alternate database

Alternate database recovery is supported on any mailbox server. In this type of recovery, the backed-up mailbox database is recovered to a new mailbox database. Alternate database recovery is supported in both Exchange Server stand-alone and database availability group (DAG) environments.

**Procedure**

1. In the NMM user interface, select the NMM client and then select **Recover > Exchange Recover Session > Database Recovery (default) > Advanced Recover**.

2. In the **Advanced Recovery** dialog box, select **Alternate Database Recovery** for recovery to an alternate database and click **Next**.
   The **Select Database** dialog box with a list of alternate databases appears, as shown in the following figure.

   **Figure 19 Select Database dialog box**

3. Select the database that you want to recover to, and then click **Next**.
   The **Exchange Recovery Summary** dialog box appears. This dialog box lists the Exchange Server recovery options and the NetWorker recovery options, and it allows you to review the details before continuing with recovery.

4. To continue with recovery, click **Start Recovery**.

### Recovering to a remote database

By performing remote recovery, you can start a roll-forward or point-in-time recovery from a mailbox server that is not actually mounted. After remote recovery starts from a DAG member server where the Mailbox database is not mounted (the Mailbox database with the passive copy) the recovery service **nsrnmmrc.exe** starts in the DAG member server on the mailbox database with the active copy.
Remote database recovery is supported only in a DAG environment. You cannot perform a remote recovery to a host that is not a part of DAG.

1. In the **Advanced Recovery** dialog box, select **Remote Database Recovery**, and then click **Next**.
   The **Select Server** dialog box appears with a list of remote databases.

2. Select the database to which you want to perform the recovery, and then click **Next**.
   The **Exchange Recovery Summary** dialog box appears. This dialog box lists the Exchange Server recovery options and the NetWorker recovery options, and it allows you to review the details before continuing with recovery.

3. To continue with recovery, click **Start Recovery**.

**Accessing archive mailboxes in recovery databases**

Microsoft does not support access to archive mailboxes in the recovery database (RDB) through MAPI. A **MAPI_E_FAILONEPROVIDER (0x8004011d)** error occurs when a MAPI application tries to log in. You can work around this limitation by using the **New-MailboxRestoreRequest** cmdlet to restore data from the archive mailbox in the recovery database.

**Procedure**

1. Get the archive mailbox GUID from the **get-mailbox** cmdlet for the user whose archive mailbox you want to restore. For example, in PowerShell, type:
   ```powershell
   C:\>Get-Mailbox <alias> | fl Name, Archive*
   ...
   ArchiveGuid : <GUID>
   ```

2. Run the **New-MailboxRestoreRequest** cmdlet. For example, in PowerShell, type:
   ```powershell
   C:\>New-MailboxRestoreRequest -RecoveryDatabase <Recovery Database Name> -RecoveryMailbox <GUID> -TargetFolder <Target Folder Name> -Identity <alias>
   ```

**Results**

This action restores the mailbox data to a live mailbox, where the user can work with it.

Recovering a deleted Exchange Server mailbox database, public folder database, or public folder mailbox database

NMM supports recovering the following Exchange Server databases outside of the Exchange VSS process:

- Exchange Server mailbox databases
- Exchange Server public folder mailboxes (Exchange Server 2013 and 2016) and public folder databases (Exchange Server 2010)

This capability allows you to recover mailbox databases and mailboxes that have been removed from the Exchange server and the Active Directory. You can also recover these items so that you can mine data from Exchange public folder mailboxes or public folder databases with third-party tools.

Procedure

1. In the NMM user interface, select the NMM client, and then click Recover > Exchange Recover Session > Database Recovery (default).
   
   If the database is not listed, select a browse time that includes the wanted backup. The EMC NetWorker Administration Guide provides details.
   
   Although the job summary does not note that the recovery is to a Windows file system, if the database is online, you cannot overwrite the live database.

2. Select the mailbox database that you want to recover, and then click Recover Options.

3. Click the Exchange tab, and then click Select Destination.

4. If you are restoring the backup to a database that already exists, then type the following command at the PowerShell cmdlet:

   ```powershell
   Set-MailboxDatabase <mailbox_database_name> -AllowFileRestore: $True
   ```

   Where `<mailbox_database_name>` is the name of the database selected as the destination for the restore operation.

5. Select Restore Deleted Database Files on File System.

6. Browse to the target location where NMM recovers the mailbox database files.

7. Click OK.

8. Recover the deleted Exchange databases.

   The following Microsoft TechNet articles provide information about recovering deleted Exchange mailboxes:

Recovering a deleted Exchange Server user mailbox

If an Exchange Server 2010 or later user mailbox is deleted, you can recover the mailbox with NMM and the Exchange Management Shell tool.

Procedure

1. Perform one of the following steps according to the Exchange Server environment:
   - For Exchange Server 2016, perform granular-level recovery on the deleted user mailbox with EMC ItemPoint for Microsoft Exchange Server.
   - For Exchange Server 2010 or 2013, perform granular-level recovery on the deleted user mailbox with either EMC ItemPoint for Microsoft Exchange Server or NMM client user interface.

   The Granular-Level Recovery chapter provides instructions.

   During the granular-level recovery operation, an error message similar to the following appears:

   Error getting item list: Error browsing folders -- Failed to fetch mailbox items. Please see libmapibrowse.raw for more information. [exch_get_mbx_list]

   You can ignore this error message and proceed by clicking OK.

2. Launch the Exchange Management Shell tool.

3. If you are restoring the mailbox to an existing mailbox database, type the following cmdlet:

   Set-MailboxDatabase <target_mailbox_name> -AllowFileRestore: $True

   Where <mailbox_database_name> is the name of the database that is selected as the destination for the restore operation.

4. To start the restore operation, type the following cmdlet:

   new-mailboxrestorerequest -sourcedatabase <GLR_database> -sourcestoremailbox "<deleted_user_mailbox>" -targetstoremailbox "<existing_user_mailbox>" -targetmailbox "<existing_user_mailbox>" -TargetRootFolder <root_folder_name> -AllowLegacyDNMismatch

   Where:
   - GLR_database is the database that was recovered with granular-level recovery.
   - deleted_user_mailbox is the deleted mailbox that you want to recover.
   - existing_user_mailbox is the mailbox location where the mailbox is recovered to.
   - root_folder_name is the root mailbox folder where the recovered mailbox is placed in.

   Refer to Microsoft documentation for more information about Exchange Management Shell tool cmdlets.

5. To monitor the status of the restore operation, type the following cmdlet:

   Get-Mailboxrestorerequest
6. After the restore operation successfully completes, log in to the target user mailbox.
7. In the target root folder, verify that the deleted mailbox items are recovered.
8. (Optional) Repeat steps 3 through 7 to recover other user mailboxes.

Performing a quick recovery of a deleted Exchange Server 2010 user mailbox

If a user mailbox is deleted, you can quickly recover the mailbox through the Exchange Management Console.

The procedure to recover an Exchange Server 2010 deleted mailbox is performed independent of NMM backup or recovery operations.

Procedure
1. In the Exchange Management Console, from the Recipient management group, under Disconnected mailbox, ensure that the deleted user mailbox entry appears.
2. Create a user mailbox with same name.
3. Disable the newly created user mailbox.
4. From the Recipient management group, click Disconnected mailbox, and then select the user mailbox that was deleted.
5. Right-click the user mailbox, and then click Connect.
6. Select User mailbox, and then click Next.
7. Select Matching user > User mailbox, and then click Next.

The deleted user mailbox is then re-created under Recipient management > Mailbox.

NOTICE

Re-created mailboxes are not always immediately visible. It might take 15 minutes to 1 hour before the mailbox is visible and accessible through Outlook.

Recovering Exchange Server mailbox, public folder database, or public folder mailbox files

You can use NMM or ItemPoint for Microsoft Exchange Server to perform a flat-file recovery or granular-level recovery (GLR) of Exchange Server mailbox databases, public folder databases, or mailbox database items.

The recovery procedure varies depending on the method you use. The recovery process is the same for all supported versions of Exchange Server, although the backup save sets and application information vary depending on the version Exchange Server you use.

Procedure
1. Backup the database using NMM.
2. Recover the files through one of the following methods:
   - Use NMM to perform a flat-file recovery of the database using one of the following procedures:
     - To recover files from a network location: Performing flat-file recovery of Exchange Server mailboxes, public folder databases, or public folder mailboxes from a network location on page 92.
Performing flat-file recovery of Exchange Server mailboxes, public folder databases, or public folder mailboxes from a network location

**Procedure**

1. Log in to the DAG node client where you performed the backup.
2. In the NMM user interface, start a recovery session.
3. From the main toolbar, select **Client**, and then select the DAG client where you performed the backup.
4. Click **View**, and then click **Refresh**.
5. From the left pane, click one of the following sequences:
   - **Recover** > **Exchange 2010 Recover Session** > **Database Recover**
   - **Recover** > **Exchange 2013 Recover Session** > **Database Recover**
   - **Recover** > **Exchange 2016 Recover Session** > **Database Recover**

   The NMM user interface shows the mailboxes, public folder databases, or public folder mailboxes that are available for recovery.

6. Select the mailbox database that you want to recover and click **Recover Options**.
7. Click the **Exchange** tab.
8. Select **Restore Deleted Database Files on File System**.
9. Browse to the target location where NMM recovers the mailbox database files.
10. Click **OK**.
11. Select the mailbox, public folder, public folder mailbox, or public folder database that you want to recover.
12. From the **Exchange Recover** toolbar, click **Recover**.
13. After the flat-file recovery completes, verify that the logs and .edb files recovered as expected in the mapped network drive.

Recovering Exchange Server mailboxes, public folder databases, or public folder mailboxes to a remote computer

To recover the Exchange Server mailboxes, a public folder database, or a public folder mailbox flat file to a remote computer, you must map a network drive and specify that network drive path as the value for a new registry entry named `ExchangeDataFilePath`.

**Procedure**

1. On the remote computer that you will recover the database to, create a folder. For example: `E:\folder`.
2. On the database availability group (DAG) node where you performed the backup, map a network drive to the folder you created on the remote computer.
For example, Z:\ is a mapped network drive on the DAG node, and Z:\ points to E:\folder on the remote computer.

3. On the remote computer, open the NMM client user interface.
4. From the main toolbar, click **Options > Configure Options**.
5. In the **Configuration Options** dialog box, next to the **Client name** field, click **Refresh**.
6. In the **Select Viewable Clients** dialog box, click the client where you performed the backup, and then click **Add**.
7. Click **OK**.
8. From the main toolbar, select **Client**, and then select the DAG client where you performed the backup.
9. From the left pane, click one of the following sequences:
   - **Recover > Exchange 2010 Recover Session > Database Recover**
   - **Recover > Exchange 2013 Recover Session > Database Recover**
   - **Recover > Exchange 2016 Recover Session > Database Recover**
   The NMM user interface shows the mailboxes, public folder databases, or public folder mailboxes that are available for recovery.
10. Select the mailboxes, public folder databases, or public folder mailboxes that you want to recover, and then click **Recover Options**.
11. Click the **Exchange** tab.
12. Select **Restore Deleted Database Files on File System**.
13. Browse to the target location where NMM recovers the files.
14. Click **OK**.
15. After the flat-file recovery completes, verify that NMM recovered the logs and .edb files to the folder you created.

**Best practices and recommendations for Exchange backup and recovery operations**

Follow the best practices to ensure optimal performance of Exchange backup and recovery operations.

- As well as scheduled full backups, you should perform a full backup of Exchange Server after:
  - Every successful recovery.
  - Upgrading to NMM from previous releases of NetWorker clients.
  - Upgrading to a new Exchange version or Service Pack.
  - You change the database directory path, the Log Path, or the System Path.
- Ensure that you have mounted all databases before you back up the Exchange Servers. Unmounted databases are not backed up.
- If you add a mailbox server to a DAG and then back up one of the databases, either refresh the NMM user interface, or close the NMM user interface and then reopen it.
If you delete Exchange objects such as databases in the Exchange Server, you cannot recover these objects until you perform disaster recovery. Do not delete objects from the Exchange Server, unless they no longer need to be recovered.

After you upgrade from the NetWorker Module for Exchange (NME) to the NMM client, you cannot recover Exchange backups that were performed with NME. To ensure that you can recover all Exchange data to the time of the upgrade, perform a full backup of Exchange data immediately after you upgrade to the NMM client.

Save sets and backup groups that include the Exchange writer cannot include any other volumes, applications, or non-Exchange items in the save set.

Exchange recovery limitations

Review the following limitation when backing up and restoring Exchange objects with NMM.

Roll-forward recovery is not possible after point-in-time restore. After you complete a successful point-in-time restore, perform a full backup of the Exchange Server so that you can perform roll-forward recovers.
CHAPTER 5

Granular-Level Recovery

This chapter includes the following sections:

- Recovering mailbox items with GLR..........................................................96
- Exchange Server GLR using EMC ItemPoint for Microsoft Exchange Server.....97
- Exchange Server GLR using the NMM UI..................................................103
Recovering mailbox items with GLR

In a conventional Exchange database restore operation, entire databases are replaced or restored. Retrieving large backups and restoring them can use significant network, memory, processor, and storage resources and might also affect production server performance.

NMM supports Granular Level Recovery (GLR), so you can restore individual items such as individual user mailboxes, mailbox folders, and messages within an Exchange database. You can browse and select individual folders from the restored data, and then restore them to the individual’s mailbox.

NMM mounts the backup set to a virtual drive, where you can browse the contents of the backup without actually moving or copying the data. During the mount process, NMM copies any required log files from the backup device. The virtual drive is created and does not require a significant amount of disk storage space. You can browse and select the recovered data from this virtual drive as if you were viewing an actual recovery database, down to the folder level.

Only when you send the restore request are actual items copied from the backup set to the user’s mailbox. If you use the NMM UI for GLR, the items are placed in a Restored items folder in the user’s mailbox, where you can browse and select the items to keep. This Restored Items folder is similar to any other folder in the mailbox.

The NetWorker Module for Microsoft Administration Guide provides more information about GLR.

GLR requirements

You must meet the requirements to recover granular Exchange data using GLR:

- If you are using EMC ItemPoint for Microsoft Exchange Server GLR, you must select Exchange GLR (includes EMC ItemPoint) when you install the NMM software.
- NetWorker 9.0 or later must be installed on the NetWorker server for Exchange Server 2010 and 2013.
- NetWorker 9.0.1 or later must be installed on the NetWorker server for Exchange Server 2016.
- You must back up the writer save set or the database save set with a GLR-compatible version of NMM:
  - For Exchange Server 2010 writer:
    APPLICATIONS:\Microsoft Exchange 2010
  - For Exchange Server 2010 database:
    APPLICATIONS:\Microsoft Exchange 2010\Database
  - For Exchange Server 2013 writer:
    APPLICATIONS:\Microsoft Exchange 2013
  - For Exchange Server 2013 database:
    APPLICATIONS:\Microsoft Exchange 2013\Database
  - For Exchange Server 2016 writer:
    APPLICATIONS:\Microsoft Exchange 2016
  - For Exchange Server 2016 database:
Applications: Microsoft Exchange 2016(Database)

The *EMC NetWorker Module for Microsoft Administration Guide* provides more information about backups.

- In firewall-enabled environments, you must provide firewall exceptions for the Windows Remote Management services:
  2. In the Inbound Rules dialog box, right-click Windows Remote Management - Compatibility Mode (HTTP-In), and then click Disable Rule.
  3. Right-click Windows Remote Management (HTTP-In), and then click Disable Rule.

**Options for Exchange GLR**

Two methods are available for performing Exchange GLR. It is recommended that you use ItemPoint for Microsoft Exchange Server to perform GLR.

You can use one of the following methods to perform Exchange server GLR:

- GLR using ItemPoint for Microsoft Exchange Server.
- GLR using the NMM UI.

If you are unable to use the NMM UI or ItemPoint for Microsoft Exchange Server for granular-level recovery, you can use the NMM Support Tools for recovery. The *EMC NetWorker Module for Microsoft Administration Guide* provides details about these tools. The following table describes which methods can be used for GLR on each Exchange Server.

<table>
<thead>
<tr>
<th>Exchange Server</th>
<th>Available GLR methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange Server 2010</td>
<td>• GLR using ItemPoint for Microsoft Exchange Server</td>
</tr>
<tr>
<td></td>
<td>• GLR using the NMM UI</td>
</tr>
<tr>
<td>Exchange Server 2013</td>
<td>• GLR using ItemPoint for Microsoft Exchange Server</td>
</tr>
<tr>
<td></td>
<td>• GLR using the NMM UI</td>
</tr>
<tr>
<td>Exchange Server 2016</td>
<td>• GLR using ItemPoint for Microsoft Exchange Server</td>
</tr>
</tbody>
</table>

**Exchange Server GLR using EMC ItemPoint for Microsoft Exchange Server**

To ensure a successful GLR operation through EMC ItemPoint for Microsoft Exchange Server, review the following information about supported environments and limitations:

- EMC ItemPoint supports Internet Explorer 8.0 and later.
Only users with administrative privileges can run EMC ItemPoint. It must be run in administrative mode.

The following versions of Microsoft Exchange Server are supported as offline source databases:

- Microsoft Exchange Server 5.5
- Microsoft Exchange Server 2000
- Microsoft Exchange Server 2003
- Microsoft Exchange Server 2007 through SP3
- Microsoft Exchange Server 2010 through SP3
- Microsoft Exchange Server 2013 through SP1
- Microsoft Exchange Server 2016

The following versions of Microsoft Exchange Server are supported as live targets:

- Microsoft Exchange Server 2007 through SP3
- Microsoft Exchange Server 2010 through SP3
- Microsoft Exchange Server 2013 through SP1
- Microsoft Exchange Server 2016

The following versions of Microsoft Outlook (32-bit versions only) are supported:

- Microsoft Outlook 2007
- Microsoft Outlook 2010
- Microsoft Outlook 2013

---

**Note**

MAPI/CDO and Microsoft Outlook 2010 or later cannot be installed on the same host.

---

**Note**

Microsoft Outlook 2016 is not supported with EMC ItemPoint for Microsoft Exchange Server.

---

During NMM installation, you must select **Exchange GLR (includes EMC ItemPoint)**.

You can use Exchange Server 2010 and later with EMC ItemPoint for Microsoft Exchange Server.


EMC ItemPoint for Microsoft Exchange Server requires Microsoft .NET Framework 3.5 SP1 and 4.0.

---

**Note**

For virtual environments, virtual operation of tape devices may have restrictions that are imposed by virtual operating systems.

For more information about installing ItemPoint for Microsoft Exchange Server, refer to the *EMC NetWorker Module for Microsoft Installation Guide*. For more information
about using ItemPoint for Microsoft Exchange Server, refer to the *EMC ItemPoint for Microsoft Exchange Server User Guide*.

**User credential and permission requirements**

Credential requirements (username and password) vary between tasks when using EMC ItemPoint for Microsoft Exchange Server. Users may also require permission and rights to perform the following:

- Connect to target Microsoft Exchange servers
- Create users/mailboxes
- Use multi-tenancy information when opening a source or target

Users may be prompted for credentials during tasks that are based on an organization's policies. For example, when:

- Connecting to a single mailbox target (not assigned to the EMC ItemPoint for Microsoft Exchange Server user)
- Connecting to target public folders

The following table provides a guideline for credential and permission requirements:

<table>
<thead>
<tr>
<th>Activity/Use Case</th>
<th>Microsoft Exchange Role</th>
<th>Credentials/Authentication</th>
<th>Permissions/Authorization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to user mailbox</td>
<td>N/A</td>
<td>User Credentials</td>
<td>Full Access Permissions</td>
</tr>
<tr>
<td>Connect to other mailbox</td>
<td>N/A</td>
<td>User Credentials</td>
<td>Full Access Permissions</td>
</tr>
<tr>
<td>Connect to all mailboxes</td>
<td>N/A</td>
<td>User Credentials</td>
<td>Full Access Permissions</td>
</tr>
<tr>
<td>Connect to all mailboxes without multi-tenancy</td>
<td>N/A</td>
<td>User Credentials</td>
<td>Full Access Permissions</td>
</tr>
<tr>
<td>Connect to all mailboxes with multi-tenancy</td>
<td>Organizational Management</td>
<td>User Credentials (Access limited to Address Book Policy)</td>
<td>Full Access Permissions</td>
</tr>
<tr>
<td>Create mailbox</td>
<td>Organizational Management</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Mailbox Creation wizard**

To use Mailbox Creation Wizard on your computer, you must have the Microsoft Exchange Server management tools for the version of Microsoft Exchange Server that you are creating mailboxes on. Ensure the Microsoft Exchange Server management tools and Microsoft Exchange Server version, service pack, and roll up level are matched.

For supported operating system and prerequisite requirements for the Microsoft Exchange Management Tools, please refer to the Microsoft Exchange Management Tools documentation for the specific version.
Limitations

Consider the following limitations when using EMC ItemPoint for Microsoft Exchange Server:

- If you have ever copied or moved a message using Microsoft Office Outlook, and later restored that same item with EMC ItemPoint, the message may be duplicated. This duplication occurs because the message ID numbers differ between EMC ItemPoint and the Microsoft Exchange Server.

- Newly created mailboxes on the Microsoft Exchange Server do not become visible within EMC ItemPoint until someone has logged on to the mailboxes with Microsoft Office Outlook, or at least one message is delivered (or copied) to the mailbox. Until one of these two events occurs, there is no physical mailbox, only directory information.

- EMC ItemPoint does not check messages or attachments for viruses when restoring them from the database. If the server antivirus program has current signature files, it should identify and protect against infected messages when the restored messages are on the live server.

- Due to the database nature of the PST file and the MAPI subsystem, PSTs opened as source will be modified.

- Mailbox Creation Wizard is not supported on Windows Server 2012 R2 as Microsoft Exchange Server 2013 or earlier Management Tools is not supported on Windows Server 2012 R2.

- The Message Table and Attachment Table Views do not support Microsoft Exchange Server 2010 or later EDB sources as Microsoft stopped supporting single instance storage with Microsoft Exchange Server 2010.

Recovering individual mailbox items with EMC ItemPoint for Microsoft Exchange Server

Use this procedure to perform GLR on individual mailbox items using EMC ItemPoint for Microsoft Exchange Server.

The *EMC ItemPoint for Microsoft Exchange Server User Guide* provides additional information about GLR procedures.

**Procedure**

1. Open the NMM client user interface.
2. From the host menu, select the NetWorker client on which the NMM client software was configured for backup.
3. If the NMM client is part of a database availability group (DAG), select the virtual client name of the DAG to which you are recovering data. You can select the virtual client from the client list attribute in the application toolbar.
4. From the left pane, select **Recover** > **Exchange Recover Session** > **Granular Level Recover**.
5. In the **Browse** tree, select the mailbox database that contains the items for recovery.
6. (Optional) To change the database mount options, follow these steps:
   a. From the taskbar, click **Recover Options**.

   The **Exchange Recover Options** window appears.
b. In the **Exchange Recover Options** window, specify the following values in the **Mount Option** pane:

- The mount path. The default mount path is the folder that is specified during installation.
- The amount of time that the backup is mounted. You can set the time-out period to 2, 4, 8, 16, or 24 hours. The default time-out period is 8 hours.

![Exchange Recovery Options window for ItemPoint GLR](image)

7. On the **NMM Recover** page, in the **Browse** tree, right-click the selected mailbox database, and then click **Mount backup**.

![Mounting the backup for ItemPoint GLR](image)

8. Open the **Monitor** page to verify that the mount operation was successful. A successful mount operation displays output similar to the following on the **Monitor** page.
9. Launch the EMC ItemPoint GUI:
   - On Windows 2008—From the **Start** menu, select Programs > EMC ItemPoint > EMC ItemPoint for Microsoft Exchange Server.
   - On Windows 2012—Select the EMC ItemPoint for Microsoft Exchange Server icon.

**Note**
The NMM UI can be left open or closed after the mounting is successful. The EMC ItemPoint GUI does not require the NMM UI after the mounts are created.

10. In the EMC ItemPoint GUI, browse the mount path location, mark the items that you need to recover, and then proceed with recovery.

You can find the mount paths on the output on the **Monitor** page after mounting the backup, or by right-clicking the database in the **Browse** tree of the **Recover** page and selecting **Mount details**.

The *EMC ItemPoint for Microsoft Exchange Server User Guide* provides the procedures for using the EMC ItemPoint GUI.

### Unmounting backups after GLR through EMC ItemPoint for Microsoft Exchange Server

After you perform GLR using ItemPoint for Microsoft Exchange Server, unmount the backup using one of the following methods:

- For standard restore operations, the backup is unmounted automatically after the restore is completed.
- If you changed the mount time in the **Exchange Recover Options** window, the backup is unmounted based on the specified timeout setting. The default timeout period for mounted backups is 8 hours.
- You can manually unmount the backup by right-clicking the BBB Mount system tray icon and clicking **Unmount Backups**.
Note

You can unmount the backup at any time after you initiate GLR, even if EMC ItemPoint for Microsoft Exchange Server is using the database.

BBB Mount system tray icon

The BBB Mount system tray icon appears when a backup is mounted.

Click the BBB Mount system tray icon to choose one of the following available actions:

- Unmount a backup.
- Extend timeout period for which the backup is mounted.
- View mount details.

Exchange Server GLR using the NMM UI

This section contains the procedures for using the NMM UI to perform GLR on Exchange Server 2010 or Exchange Server 2013.

You can restore to an Exchange Server recovery database (RDB) without disrupting the active production databases and servers. After you restore to the RDB, you can browse and select individual mailboxes to restore to the production server while it is online.

After a successful GLR and until you perform another GLR or a different type of a restore operation, the GLR RDB remains mounted and maintains a Read connection with the original device. You must delete the GLR RDB before you can perform a Stage operation. Closing the NMM GUI removes the GLR RDB.

NMM UI GLR requirements

Consider the following requirements before you perform GLR using the NMM UI:

- NMM does not support GLR in an Exchange Server 2016 environment using the NMM UI. If you are using Exchange Server 2016, perform GLR with EMC ItemPoint for Microsoft Exchange Server.
- The backup must be a full backup. Incremental backups are incompatible with Exchange GLR.
- Public folders or objects cannot be recovered using GLR, and they are not displayed in the list of folders available for GLR. GLR is supported only for backups that reside on GLR-compatible devices, such as AFTD or Data Domain devices.
- When NMM browses folders with more than 10,000 items, NMM might take a significant amount of time to display these items. In this case, do one of the following:
  - Restore the entire folder using Exchange GLR without browsing into the folder.
  - Restore the database to an RDB, and then browse from it.

Recovering individual mailbox items using GLR through the NMM UI

The recovered items are placed in a new Restored Items folder in the user’s mailbox.
Note

You can mount only one virtual drive at a time and browse one recovery database (RDB) at a time.

Procedure

1. Open the NMM client user interface.
2. From the host menu, select the NetWorker client on which the NMM client software was configured for backup.
3. If the NMM client is part of a database availability group (DAG), select the virtual client name of the DAG to which you are recovering data. You can select the virtual client from the client list attribute in the application toolbar.
4. From the left pane, select Recover > Exchange Recover Session > Granular Level Recover.
5. Select the mailbox database to recover.

   **Figure 24** Individual mailbox databases

<table>
<thead>
<tr>
<th>Browse</th>
<th>Search</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Database Structure" /></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Lgb</td>
<td>LargeDatabase</td>
</tr>
</tbody>
</table>

   Only full backups are compatible with GLR.

6. From the Exchange Server Session toolbar, click Recover.
   - If the backup is GLR-compatible, the recovery continues.
   - If the backup is not GLR-compatible, the software prompts you to select a version of the save set that is GLR-compatible.
     To select a GLR-compatible save set:
     a. Click Yes.
     b. Select a backup from the list of backups.
     c. Select Use selected item backup time as the new browse time, and then click OK.

7. In the Exchange Recovery Summary dialog box, click Start Recover.

8. To clear the Recovered RDB Mailbox Items dialog box, click OK.

9. Expand the database to find user mailboxes and folders, and then select the items you need to recover.

10. Click Recover, and then click Start Recover to recover the selected folders.

After you finish

To recover a different version of the selected database, repeat step 5 through step 10. Changing to a different version of the database dismounts the currently mounted virtual drive. NMM creates a new virtual drive with the data from the newly selected database.
Performing a GLR to an alternate mailbox using the NMM UI

You can recover individual mailbox items, including folders, from any number of active users to any other active user in the Exchange organization. Recovery is not supported for deleted users.

**Note**

Folder names containing forward slashes (/) and backward slashes (\) are not recovered.

When you recover to an alternate mailbox, NMM creates a Recovered Items folder under the root of the alternate mailbox. Inside this Recovered Items folder, NMM creates sub folders that contain the contents of each user’s recovered mailbox items.

For example, you want to recover some of UserYY and UserZZ’s mail items to UserA’s mailbox. NMM creates a folder in UserA’s mailbox called Recovered Items YYYY-MM-DD hh:mm:ss, where YYYY-MM-DDD hh:mm:ss indicate the date and time of the recovery. Inside that folder, NMM creates sub-folders for each user, for example UserYY and UserZZ, and re-creates each user’s respective folder structure and mail items.

**Procedure**

1. Open the NMM client user interface.
2. From the host menu, select the NetWorker client on which the NMM client software was configured for backup.
3. If the NMM client is part of a database availability group (DAG), select the virtual client name of the DAG to which you are recovering data. You can select the virtual client from the client list attribute in the application toolbar.
4. From the left pane, select **Recover > Exchange Recover Session > Granular Level Recover**.
5. Select the mailbox database to recover.

**Figure 25** Individual mailbox databases

<table>
<thead>
<tr>
<th>Browse</th>
<th>Search</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Directory structure" /></td>
<td>Name</td>
</tr>
<tr>
<td><img src="image" alt="Directory structure" /></td>
<td>Name</td>
</tr>
</tbody>
</table>

Only full backups are compatible with GLR.

6. From the **Exchange Server Session** toolbar, click **Recover**:
   - If the backup is GLR-compatible, the recovery continues.
   - If the backup is not GLR-compatible, the software prompts you to select a version of the save set that is GLR-compatible.
   To select a GLR-compatible save set:
     a. Click **Yes**.
     b. Select a backup from the list of backups.
     c. Select **Use selected item backup time** as the new browse time, and then click **OK**.
7. In the **Exchange Recovery Summary** dialog box, click **Start Recover**.
8. To clear the **Recovered RDB Mailbox Items** dialog box, click OK.

9. Expand the database to find user mailboxes and folders, and then select the items you need to recover.

10. In the **Advanced Recovery** dialog box, select **Alternate Mailbox User**.

11. Select the user account for the mailbox:
   - To search for a specific user:
     a. In the **Name** dialog box, type a name.
     b. Click **Search**.
     c. Confirm the user.
   - To list all users in the Exchange organization:
     a. Click **List All Users**.
     b. Select the user from the list that appears.

12. Click **Next**.
    The recovery starts.

**Performing a GLR on an archive user mailbox using the NMM UI**

The NMM software does not support the Exchange Server archive mailbox feature. To perform an item-level recovery of an archive user mailbox, use the **New-MailboxRestoreRequest** command to recover personal PST information from an recovery database (RDB), which is recovered by NMM.

**Procedure**

1. Create an archive mailbox with a folder, and add a few email messages to the folder.

2. Back up the mailbox database that contains the archive mailbox.

3. Perform RDB recovery.

4. Run the following command in the Exchange Management Shell to retrieve the **ArchiveGuid** for the archive mailbox:

   ```powershell
   [>] C:\Windows\system32>get-mailbox arch2 | Fl Name, Archive*
   Name : arch2
   ArchiveDatabase : ArchiveDB2
   ArchiveGuid : 3daa752d-a77c-47b7-ad6e-5a2aa6ee2579
   ArchiveName : {Personal Archive - arch2}
   ArchiveQuota : 50 GB (53,687,091,200 bytes)
   ArchiveWarningQuota : 45 GB (48,318,382,080 bytes)
   ArchiveDomain :
   ArchiveStatus : None
   ```

5. Run the following command in the Exchange Management Shell to recover Archive PST information:

   ```powershell
   [>] C:\Windows\system32>New-MailboxRestoreRequest -RecoveryDatabase RDB-arch -RecoveryMailbox 3daa752d-a77c-47b7-ad6e-5a2aa6ee2579 -TargetFolder arch-folder -Identity arch2
   ```

6. Confirm that you want to perform the recovery.
Performing a GLR to a PST with the NMM UI

You can recover a user mailbox from any active user in the Exchange organization and place the recovered mailbox items in a .PST file. Recovery is not supported for deleted users.

Before you begin
The PST role is not available by default. To configure the role, run the following PowerShell cmdlet:

```
New-ManagementRoleAssignment -Role "Mailbox Import Export" -<Exchange administrator>
```

where `<Exchange administrator>` is the Exchange administrator username.

Procedure

1. Open the NMM client user interface.
2. From the left pane, select **Exchange Recover Session**, and then select one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDB Mailbox Recover (default)</td>
<td>Browse and recover Exchange 2010 and 2013 items from an existing RDB database. Select this option to perform a PST export from an existing RDB.</td>
</tr>
<tr>
<td>Granular Level Recover</td>
<td>Browse and recover items from databases without first having to restore the database to an RDB. Select this option if no RDB currently exists.</td>
</tr>
</tbody>
</table>

3. If no databases appear, click **View > Refresh**.
4. Select the database in the NMM user interface.
   If the database is not listed, select a browse time that includes the wanted backup. The *EMC NetWorker Administration Guide* provides details.
5. From the taskbar, select **Recover**.
6. In the **Recover Options** dialog box, click the **Exchange** tab.
7. In the **PST Target** field, type a filepath for the target PST file using universal naming convention (UNC).
   The UNC file specification should include a file path and file name ending in .PST. The .PST file does not have to exist, but the NMM GUI must be able to write to the target location.
8. Click **OK**.
9. In the **Recover** dialog box, click **Start Recover**.

Note

Database Recover overwrites existing production mailboxes, which does not produce the correct results.
10. In the **Exchange Recover Options** dialog box, select the location and the name of the PST file. 

Due to a Microsoft restriction, NMM does not support PST recovery for a single mail item.

If no .PST file is specified, the items that are selected for recovery are recovered to the production server.

After a recover to the .PST file has completed, the field containing the location and name of the PST file is cleared.
CHAPTER 6
Bare-Metal Recovery

This chapter includes the following sections:

- Planning bare-metal recovery ................................................................. 110
- Backing up a standalone Exchange Server for BMR ................................ 114
- Backing up an Exchange Server DAG for BMR ..................................... 115
- Performing BMR of an Exchange Server ............................................. 117
Planning bare-metal recovery

This section provides an overview of the Windows bare-metal recovery (BMR) solution and considerations when planning a BMR.

Overview

Bare-metal recovery (BMR) is a technique in the field of data recovery and restoration where the backed up data is available in a form that allows you to restore a system from bare metal, that is, without any requirements as to previously installed software or operating system.

Typically, the backed up data includes the necessary operating system, applications, and data components to rebuild or restore the backed up system to an entirely separate piece of hardware. The hardware receiving the restore should have a similar configuration as that of the hardware that was the source of the backup.

The basic BMR is the process of bringing up a server after a disaster and ensuring that the system recovers with the operating system, the applications, and the data as they were at the time of the failure.

Restoring a server to the exact configuration that it had at the time of its destruction can be a difficult task. When this restoration is performed to another hardware, it can add to the complexity of the process and can be time-consuming. Windows BMR solution provides a flexible and reliable method of restoring a server after a disaster.

System requirements

The following sections list requirements to perform Windows BMR. However, the EMC NetWorker Online Software Compatibility Matrix at http://compatibilityguide.emc.com:8080/CompGuideApp/ provides the latest information about the system requirements to perform Windows BMR by using NMM.

Supported operating systems

The EMC NetWorker Online Software Compatibility Matrix at http://compatibilityguide.emc.com:8080/CompGuideApp/ provides information about the operating systems and versions that NMM supports.

Supported Microsoft applications

The EMC NetWorker Online Software Compatibility Matrix at http://compatibilityguide.emc.com:8080/CompGuideApp/ provides information about the Microsoft applications and versions that NMM supports.

NetWorker software version requirements

The EMC NetWorker Online Software Compatibility Matrix at http://compatibilityguide.emc.com:8080/CompGuideApp/ provides information about the NetWorker software versions that NMM supports.

Use the NetWorker Windows BMR 32-bit ISO image to recover an x86 operating system on either an x86 or x64 computer.

Use the NetWorker Windows BMR 64-bit ISO image to recover only an x64 operating system on an x64 computer.
Microsoft BMR requirements

Perform BMR recoveries to the same or similar hardware, and physical to virtual environment.

The following Microsoft KB article provides the requirements to perform a BMR to similar hardware:

http://support.microsoft.com/kb/249694

CPU requirements

Consider the following CPU requirements:

- The operating system architecture and the processor architecture must match.
- Basic Input/Output System (BIOS) or Unified Extensible Firmware Interface (UEFI) must match.
- You can treat AMD or Intel processors as being the same if they follow the same architecture. You can recover the operating system backup of an AMD x64 computer to an Intel x64 computer. The process is reversible.
- You can restore the backup of an x86 operating system version only to an x86 processor computer.
- You can restore the backup of an x64 operating system version only to an x64 processor computer.

Hard disk requirements

Consider the following hard disk requirements:

- The disk or RAID drivers that are used in the old system must be compatible with the disk or RAID controllers in the new system.
- For each critical disk on the BMR target system, the startup hard disk capacity on the new system must be greater than or equal to the capacity on the old system. BMR fails if the capacity is smaller by even a single byte.
- Windows BMR supports IDE, SATA, or SCSI hard disks. You can perform the backup on one type of hard disk and recover on another type. For example, SAS to SATA is supported.
- You must restore the backup to the same logical disk numbers as on the original server. You cannot use different logical disk numbers on the target system to recover the critical volumes such as the operating system volume.
- Ensure that the RAID setup on the destination computer does not interfere with the disk order of the hard disks.

NIC driver requirements

To use different Network Interface Card (NIC) after a Windows BMR recovery, install new NIC drivers that match the NIC in the new computer after Windows starts on the new server.

Critical and noncritical volume requirements

Consider the following critical and noncritical volume requirements:

- Windows BMR backs up only critical volumes, and can be used for offline disaster recovery. Use the NetWorker client to back up the non-critical volumes.
Note

NetWorker considers only system volume as a critical volume. If you have installed a Microsoft application on a drive other than the system drive, the drive is not considered as critical. On Windows Server 2008 R2, a volume is critical if a Microsoft application has installed a Windows service on it, but on Windows Server 2012, a volume that has a Windows application service installed is not critical.

- To make a volume critical on Windows Server 2012, set the value of the `HKLM\System\CurrentControlSet\Control\SystemWriter\ReportWin32ServicesNonSystemState` registry key to 0. This ensures that BMR includes the Microsoft application binaries, and the volume on which they are installed is marked as critical.

System Reserved Partition requirements

Ensure that System Reserved Partition (SRP) is online before you perform a BMR backup. Otherwise, the backup fails and displays the following error messages:

84687:save: Unable to get volume information of file system \\?\\Volume{245204f6-5ff7-11e2-a3ac-806e6f6e6963}': The device is not ready. (Win32 error 0x15). VSS OTHER: ERROR: VSS failed to process snapshot: The shadow copy provider had an unexpected error while trying to process the specified operation. (VSS error 0x8004230f)

90108:save: Unable to save the SYSTEM STATE save sets: cannot create the snapshot.

86024:save: Error occured while saving disaster recovery save sets.

If SRP is offline, perform the following steps to bring it online:

1. In the WinPE command prompt, type `diskpart` and press Enter.
2. Run the following command to display the list of volumes:
   `DISKPART> list volume`
3. Run the following command to select the volume that is offline:
   `DISKPART> select <volume_name>`
4. Run the following command to bring the selected volume online:
   `DISKPART> online volume`

Protecting an environment before a disaster

To prepare for disaster recovery, back up application data and other necessary files.

Procedure

1. Use NetWorker client to back up non-application data.
   The *EMC NetWorker Administration Guide* provides details about using the NetWorker client to backup non-application files.

2. If you use a NetWorker server earlier than 9.0.x, create a NetWorker group without enabling the Snapshot option. Otherwise, create a policy.

3. Create a NetWorker client resource, and assign it to the group that you created in step 2.
4. Configure the NetWorker client resource by typing ALL in the Save set field, and clearing the Backup command and Application information fields.

5. Perform a backup.

6. Use NMM to perform a full backup of application data.

The NMM application specific user guides, available from EMC Online Support, provide details about how to perform a full backup.

**BMR by using NetWorker and NMM**

Perform Windows file system backup and recovery by using the NetWorker client, and application-specific backup and recovery by using NMM.

---

**Note**

Specific information about how to backup and recover Microsoft applications in NMM 9.1 is provided in application-specific user guides.

NetWorker disaster recovery provides an automated BMR solution by using the Windows ASR writer and other VSS writers to identify critical volumes that are required to perform a disaster recovery on a disabled system. BMR is performed offline, that is, when the Windows operating system is inactive. This avoids the necessity to manually reinstall Windows, and the problems that occur when operating system files are being restored to an active Windows system.

NMM 9.1 is compatible with the NetWorker 9.1 client, which provides a true BMR capability for Windows Server 2012 R2, Windows Server 2012, Windows Server 2008 R2, and Windows Server 2008. This capability is built into the NetWorker client and provides BMR support to the same or similar hardware. For Windows BMR, you should download the ISO recovery boot image file from EMC Online Support (https://support.emc.com). The ISO image provides a wizard that allows you to format disks, recover Windows critical volumes from backup, and restart the server to bring it back online.

To support a NetWorker Windows BMR recovery, download the Windows BMR image from EMC Online Support (https://support.emc.com). This download enables you to create a bootable Windows BMR ISO that contains NetWorker binaries and a wizard, which controls the recovery process.

The "Windows Bare Metal Recovery to Physical or Virtual Computers" section in the *EMC NetWorker Administration Guide* provides detailed information about how to use the NetWorker Windows BMR image to perform a BMR recovery on protected hosts and VMware virtual machines.

---

**NOTICE**

For all the Microsoft applications, after performing Windows disaster recovery and restarting the system, check all the disk and volume configurations. Usually, the disks and volumes appear as on the original system.

However, it is possible, especially in BMR scenarios, that the volume or disk signatures do not match the original ones, and the non-critical volumes or disks are offline and not mounted. Use the Microsoft Disk Manager to bring the volumes and disks online, and then restart the system for drive letter reassignments. Assign the same drive letters that existed before the BMR. Non-critical volumes that the mount points access might have a similar issue.
Back up a standalone Exchange Server for BMR

This section contains information about creating client resources to back up a standalone Exchange Server for bare-metal recovery (BMR).

Creating client resources by using the NetWorker Client Backup Configuration wizard

Create two client resources to back up the application data and the file system data which includes the ALL save set.

The Backup chapter provides information about how to create a client resource to back up the application data.

The "Creating a client resource with the Client Backup Configuration Wizard" section in the EMC NetWorker Administration Guide provides information about how to create a client resource to back up the file system data.

Creating client resources by using the Client Properties window

Create two client resources for the standalone Exchange Server. Use one client resource to back up the system data (critical volumes) and the other client to back up the application data (non-critical volumes).

Procedure

1. In the Administration view of the NetWorker Management Console, create a policy, a workflow, a group, and an action for system backup.

   The Data Protection Policies chapter in the EMC NetWorker Administration Guide provides information.

2. Create a client resource for system backup:

   a. In the NetWorker Administrator window, click Protection.

   b. In the expanded left panel, right-click Clients and select New.

      The Create Client dialog box appears.

   c. In the Name field, type the name of the client resource.

   d. Click OK.

3. In the right panel, right-click the client resource and select Modify Client Properties.

4. In the Client Properties dialog box:

   a. On the General tab:

      • In the Group list, select the group that you created in step 1.

      • In the Save set field, type ALL.

         If you have installed Exchange Server 2013 on a drive other than the system drive, type the drive letter also. For example, E:\.

   b. On the Apps & Modules tab, ensure that the Backup command and Application information fields are clear.

   c. Specify other fields according to the requirements.
d. Click OK.

5. Perform the backup.
   Ensure that the backup completes successfully.

6. By using the Administration view of the NetWorker Management Console, create a policy, a workflow, a group, and an action for application backup.
   The Data Protection Policies chapter in the *EMC NetWorker Administration Guide* provides information.

7. Create a client resource for application backup.

8. Perform step 2 for the client resource created for application backup.

9. In the **Client Properties** dialog box:
   a. On the **General** tab:
      - In the **Group** list, select the group that you created for application backup.
      - In the **Save set** field, type the save set. For example, APPLICATIONS:\Microsoft Exchange 2016 or APPLICATIONS:\Microsoft Exchange 2013.
   b. On the **Apps & Modules** tab:
      - In the **Backup command** field, type nsrnmmsv.
      - In the **Application information** field, type the following:
        
        NSR_EXCH_BACKUP=<preferred/passive/Active>
        NSR_EXCH_CHECK=<Yes/No>
   c. Specify other fields according to the requirements.
   d. Click OK.

10. Perform the backup.
    Ensure that the backup successfully completes.

### Backing up an Exchange Server DAG for BMR

This section contains information about creating client resources to back up an Exchange Server DAG for bare-metal recovery (BMR).

### Creating client resources

Create client resources for each database availability group (DAG) node and instance.

Manually create client resources to back up the system data (critical volumes) of each DAG node, including the **ALL** save set, by using the Client Properties window in NMC. Then, create one client resource for the DAG instance to back up the application data (non-critical volumes).

**Procedure**

1. In the Administration view of the NetWorker Management Console, create a policy, a workflow, a group, and an action for system backup.
The Data Protection Policies chapter in the *EMC NetWorker Administration Guide* provides information.

2. Create a client resource for system backup:
   a. In the NetWorker Administrator window, click Protection.
   b. In the expanded left panel, right-click Clients and select New.
      The Create Client dialog box appears.
   c. In the Name field, type the name of the client resource.
   d. Click OK.

3. In the right panel, right-click the client resource and select Modify Client Properties.

4. In the Client Properties dialog box:
   a. On the General tab:
      - In the Group list, select the group that you created in step 1.
      - In the Save set field, type ALL.
         If you have installed Exchange Server 2013 on a drive other than the system drive, type the drive letter also. For example, E:\.
   b. On the Apps & Modules tab, ensure that the Backup command and Application information fields are clear.
   c. Specify other fields according to the requirements.
   d. Click OK.

5. Repeat steps 2 through 4 to create client resources for system backup of each DAG node.

6. Perform the backup.
   Ensure that the backup successfully completes.

7. By using the NetWorker Administration GUI, create a policy, a workflow, a group, and an action for application backup.

   The Data Protection Policies chapter in the *EMC NetWorker Administration Guide* provides information.

8. Create a client resource for application backup, including the ALL save set, by using one of the following methods:
   - The Client Configuration wizard—The Backup chapter provides information about how to use the Client Backup Configuration wizard to create a client resource to back up the application data.
     The "Creating a client resource with the Client Backup Configuration Wizard" section in the *EMC NetWorker Administration Guide* provides information about how to create a client resource to back up the file system data.
   - The Client Properties window in NMC—Use the following steps:
     a. Perform step a through step d of step 2 to create a client resource for application backup.
     b. In the Client Properties dialog box:
a. On the **General** tab:
   - In the **Group** list, select the group that you created for application backup.
   - In the **Save set** field, type the save set. For example, APPLICATIONS:\Microsoft Exchange 2016 or APPLICATIONS:\Microsoft Exchange 2013.

b. On the **Apps & Modules** tab:
   - In the **Backup command** field, type `nsrnmmsv`.
   - In the **Application information** field, type the following:
     - `NSR_FEDERATED_BACKUP=yes`
     - `NSR_FEDERATED_PSOL=<DAG_MEMBER_NODES>`
     - `NSR_EXCH_DAG=<DAG_INSTANCE_NAME>`
     - `NSR_EXCH_BACKUP=<preferred/passive/Active>`
     - `NSR_EXCH_CHECK=<Yes/No>`

c. Specify other fields according to the requirements.

d. Click **OK**.

9. Perform the backup.
   Ensure that the backup successfully completes.

**Performing BMR of an Exchange Server**

**Procedure**

1. Perform the procedures that the "Performing a Windows BMR to physical or virtual computers" section in the *EMC NetWorker Administration Guide* describes.

2. After the recovery completes, restart the host to start all of the Exchange services.

3. After the host restarts, ensure that you meet the following requirements:
   - You have recovered all critical volumes.
   - You have created all non-critical volumes with the exact drive letters that the volumes had before the disaster.
   - You have selected a database, and performed recovery.
   - You have successfully mounted the database after the recovery, and checked whether the recovery process has successfully recovered all email messages.
CHAPTER 7
Troubleshooting

This chapter includes the following sections:

- Troubleshooting general errors ................................................................. 120
- Troubleshooting backups ........................................................................ 121
- Troubleshooting recovery ......................................................................... 122
- Troubleshooting granular-level recovery ............................................. 124
Troubleshooting general errors

This section explains how to resolve general issues you might encounter while using NMM with Exchange Server.

User mailbox structure is distorted in Outlook Web Access after an Exchange Server 2016 PIT restore operation

**Problem**

After a point-in-time (PIT) restore operation of an Exchange Server 2016, when you view a user mailbox with Outlook Web Access, the mailbox structure appears distorted.

**Solution**

Clear the cache of the web browser you are using, and then reconnect to Outlook Web Access. After you clear the cache, the mailbox structure will appear correctly.

PST export operations stall

**Problem**

Some versions of Exchange Server 2013 do not create all the necessary Exchange Security Groups in Active Directory, which can cause PST export operations to stall in either the Queued or InProgress state.

**Solution**

Run the Exchange administrator configuration tool to update the administrator account.

If the PST export operation remains stalled, perform the following steps:

1. Stop the Exchange Search and Exchange Search Host Controller services.
2. Dismount the database that contains the NMM Backup User's mailbox.
3. Delete the Content Index folder from the database.
   
   This folder is located in the same folder as the database, and its name will be the GUID assigned to the database. For verification, obtain the GUID by typing the following PowerShell cmdlet:

   \[Get-MailboxDatabase [database name] -status | fl guid\]

4. Restart the Exchange Search and Exchange Search Host Controller services.
5. Wait for the content indexing status to become Healthy or Crawling.
   
   View the content indexing status by typing the following PowerShell cmdlet:

   \[Get-MailboxDatabaseCopyStatus [database name]\[server name] | fl ContentIndexState\]

6. Retry the PST export.
Troubleshooting backups

This section explains issues that might occur during the backup process for an Exchange environment, and provides steps to resolve or work around the issues.

Unable to browse mailbox items from a recovered database

Problem
If you are unable to browse mailbox items from a recovered database, you must restore the original (source) mailbox to an alternate (target) mailbox by running the `New-MailboxRestoreRequest` PowerShell cmdlet. Microsoft provides a full list of syntax and parameters for this cmdlet.

Solution
Use the `New-MailboxRestoreRequest` PowerShell cmdlet to restore the mailbox. The following Microsoft article provides more information about this cmdlet:


The following example shows the `New-MailboxRestoreRequest` cmdlet with sample parameters:

```
New-MailboxRestoreRequest -SourceDatabase $RDBNAME -
SourceStoreMailbox $GUID_OF_MAILBOX_YOU_WANT_TO_RESTORE -
TargetMailbox $ORIGINAL_USER_MAILBOX -Targetrootfolder
<Folder_to_restore_into> allowlegacydnmismatch $true
```

Unmounted or offline databases are skipped

Problem
If a database is unmounted or offline when a backup is performed, the backup process skips that database. Generally, this omission is not an issue because databases that are not mounted are not in production.

Event log error: Microsoft Exchange Replication service VSS Writer failed

Problem
A failed or canceled backup of a passive copy might write an error in the Event log that states that the Microsoft Exchange Replication service VSS Writer failed. However, this condition might be temporary.

Solution
If this backup failure and error occur, perform one of the two following solutions:

- If you must perform an immediate backup, stop and then restart the Microsoft Exchange Replication Service writer.
- If you wait approximately 15 minutes, the Exchange server automatically corrects this condition.

NTFS softlinks are skipped by default in Windows VSS backups

Problem
NMM Windows File System backups that use the NMM Windows VSS client skip NTFS softlinks (also known as symbolic links or symlinks). Also, if an Exchange
Troubleshooting

Server is configured to save either database files or log files to a softlink path, backups fail. This issue is known, but a fix is unavailable at this time.

MAPI browsing fails in Client Access Server (CAS) array or Network Load-Balancing (NLB) setup

Problem
Sometimes, when the CAS server is set to a CAS array or NLB in the NMM user interface, MAPI browsing fails in Client Access Server (CAS) array or Network Load-Balancing (NLB) setup. The failure can be due to the NLB configuration, NLB type, firewall setup, or other error.

Solution
Set up the individual CAS servers to communicate directly with the CAS server in such setups, instead of creating a CAS Array or NLB through the NMM user interface.

Unhandled exception occurs during item-level recovery for Exchange Server 2010 GLR RDB

Problem
When you perform item-level recovery to an alternate user mailbox for Exchange Server 2010 GLR, an unhandled exception might occur.

Solution
Perform the following steps:
1. Close and reopen the NMM UI.
2. Perform GLR.
3. Perform item-level recovery.

Troubleshooting recovery

This section explains issues that might occur while performing an Exchange recovery, and provides steps to resolve or work around the issues.

Exchange Server 2010 RDB alternate mailbox item-level recovery fails with error

Problem
Alternate mailbox item-level recovery for Exchange Server 2010 RDB fails with error:
An unspecified error has occurred. 1 0 19 E_FAIL.

Solution
The target user must log in to the mailbox through the Outlook Web Application and send a few test mails, and then perform item-level recovery to target user mailbox.
Unhandled exception occurs during item-level recovery for Exchange Server 2010 GLR RDB

Problem
When you perform item-level recovery to an alternate user mailbox for Exchange Server 2010 GLR, an unhandled exception might occur.

Solution
Perform the following steps:
1. Close and reopen the NMM UI.
2. Perform GLR.
3. Perform item-level recovery.

In Exchange Server 2010, an unhandled exception occurs when mounting an RDB after failed recovery

Problem
Occasionally, after a failed RDB recovery, when the RDB is dismounted and the NMM user interface is left open for a few days without use, when the RDB is remounted, an unhandled exception occurs.

Solution
Close and reopen the NMM user interface.

In Exchange Server 2010, RDB item-level recovery fails with “insufficient permissions to access mailbox” error

Problem
If the mailbox database where the currently logged-in user mailbox resides is not mounted, an RDB item-level recovery might fail with the following error message:
Insufficient permissions to access mailbox

Solution
To browse the contents in RDB, ensure that the mailbox database where the currently logged-in user mailbox resides is mounted. MAPI communicates with the RDB mailbox through the currently logged-in user mailbox.
For example, if the user is logged in as Administrator, the mailbox database that contains the Administrator mailbox should be mounted.

Cannot browse Exchange Server 2010 RDB on a stand-alone server

Problem
Exchange Server 2010 must have an administrative mailbox to browse an RDB with NMM. This mailbox is created by default. Occasionally, the Active Directory entry for this mailbox becomes corrupt which causes Exchange to respond with one of the following reactions:
- The mailbox does not exist.
- The user (administrator) already has a mailbox and does not let you create a mailbox.

Solution
Perform the following steps:
1. Manually remove all Exchange Active Directory entries for the administrator using ADSI edit. 
The administrator is visible.
2. Re-create a mailbox for the administrator. 
   After the new mailbox is created, you can browse the RDB.

**Troubleshooting granular-level recovery**

**Troubleshooting EMC ItemPoint for Microsoft Exchange Server GLR**
To verify that EMC ItemPoint for Microsoft Exchange Server is properly configured, run the NMM Configuration Checker on the NMM client. The *EMC ItemPoint for Microsoft Exchange Server User Guide* provides information about troubleshooting EMC ItemPoint GLR.

**Troubleshooting NMM UI GLR**
If you try to perform GLR after upgrading to a newer version of NMM, the operation can fail. To resolve this issue, delete the following MAPI profile registry keys in the following order:

1. `HKEY_LOCALMACHINE\Software\Legato\NetWorker\RecoverOptions\MapiProfile`
2. `HKEY_CURRENT_USER\Software\Microsoft\Windows NT\CurrentVersion\Windows Messaging Subsystem\Profiles\Legato NetWorker`

After you delete these registry keys, GLR operations should complete successfully.

**Exchange GLR failing to establish a Client Direct session**

**Problem**
The Exchange Server fails to establish a Client Direct session. The Client Direct feature must be enabled to perform GLR.

**Solution**
To verify that the environment has Client Direct enabled, perform the following steps:

1. Validate that the NetWorker device is enabled for Client Direct. 
   This verification must only be performed for AFTD devices. Data Domain is automatically enabled for Client Direct. The *EMC NetWorker Administration Guide* provides more information about Client Direct.
2. Validate that the client has name resolutions for the systems. 
   If Data Domain is being used, ensure the client has name resolution for the Data Domain device. If an AFTD storage node is being used, ensure the client has name resolution for the storage node.
3. Check the application logs directory in the NetWorker Virtual File System (NWFS) log file, *nwfs.raw*, and look for messages confirming that a Client Direct session was established.
   - The message "Performing Direct File Access Restore" confirms that a Client Direct session is successfully established.
   - The following messages indicate that a Client Direct session could not be established:
4. Run the following `save` command from the command prompt:

```
PS C:\Program Files\EMC NetWorker\nsr\bin> save -D1 -a DIRECT_ACCESS=yes -b networker_pool 'C:\Windows \System32\drivers\etc\hosts'
```

Where `networker_pool` is the NetWorker pool containing the volumes where the savesets for recovery reside.

5. Check the output for messages indicating the Client Direct session is established:

```
10/16/16 23:59:27.094472 Default DFA handling by client is 'Fallback'
10/16/16 23:59:27.094472 DIRECT_ACCESS=yes: Client direct set to 'Yes'
10/16/16 23:59:27.129477 Device attribute block size is 262144
10/16/16 23:59:29.185589 libDDBoost version: major: 3, minor: 3, patch: 0, engineering: 2, build: 545054
10/16/16 23:59:29.197590 load ddp_get_file_segment_type 129292:save: Successfully established Client direct save session for save-set ID '889485007' (mb-vm-sql-2.dpsg-sea.emc.com:C:\Windows\System32\drivers\etc\hosts) with Data Domain volume 'ddveselssemccom.002'.
10/16/16 23:59:29.299596 using DFA save for ssid = 889485007
10/16/16 23:59:29.299596 ssid 889485007 using DFA save to `mb-vm-nw-2`
10/16/16 23:59:29.299596 Successfully setup direct saves
```

6. (Optional) If the `save` command fails:

   a. Run the `save` command again after replacing `-D1` to `-D3`:
   ```
   PS C:\Program Files\EMC NetWorker\nsr\bin> save -D3 -a DIRECT_ACCESS=yes -b networker_pool 'C:\Windows \System32\drivers\etc\hosts'
   ```
   Where `networker_pool` is the NetWorker pool containing the volumes where the savesets for recovery reside.

   b. Check for output messages indicating the Client Direct session is established.

   c. If a Client Direct session is not established, find the messages indicating the cause of the failure, and fix the problem as required.

### Cannot enable a Client Direct session and GLR failing as a result

#### Problem
Client Direct is required for Exchange GLR, including GLR of backups taken with a previous version of NMM. If you cannot enable Client Direct for either policy or technical reasons, use the following workaround to allow GLR to continue without Client Direct.

#### Solution
1. Create a folder and name it "debug" in the \nsr\ directory, if the folder does not already exist.
2. Within the "debug" folder, create an empty file and name it "nodirectfile" with no file name extension.
   You may be required to create the "nodirectfile" file from a DOS Shell command line.
NOTICE

This workaround disables Client Direct for all client operations, including subsequent backups. This workaround is against NMM best practices and you may run into timeout and other restore issues if you do not enable Client Direct.